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Installing the software

SETUP.EXE

RISK, like most Windows programs, is provided in a special compressed format that cannot be directly copied to the user's system.  A Windows program, called SETUP.EXE, is provided on disk 1 of the set of distribution disks.  This program uncompresses the RISK program files and copies them to the  hard disk.  SETUP.EXE is run by selecting File Run (Alt FR) from the Windows program manager menu.  When the Run dialog box is displayed, type d:SETUP.EXE, where d is the disk drive containing disk 1 of the RISK distribution set of disks.  Then press ENTER.  A warning about the files that will be copied to the hard disk will be displayed.  Select the Continue button to install the program.  Select the Cancel button to discontinue setup.  

SETUP.EXE will ask for a subdirectory to install the RISK files into.  The default subdirectory is C:\RISK.  If this is satisfactory, press ENTER.  If the default is not satisfactory, enter the name of the appropriate subdirectory.

After SETUP.EXE has finished installing the model, it will ask for the name of a program group for the model.  If a program group is not selected, a new program group called RISK will be created.

Uninstalling software

RISK can be uninstalled by erasing all files in the subdirectory where RISK was installed.  In addition, all of the DLLs and VBXs that SETUP.EXE copied to the hard disk must be erased from the hard disk.  Before erasing these files, be sure no other programs use them.  The files that may be erased are:

· CMDIALOG.VBX

· GRAPH.VBX

· GSWDLL.DLL

· GSW.EXE

· SPIN.VBX

· GRID.VBX

· DWVSTAMP.VBX

· SPREAD20.VBX

· MSAES110.DLL*

· MSAJT110.DLL*

· VBDB300.DLL*

· VBRUN300.DLL*

· SHARE.EXE**

SETUP.EXE installs these files in the WINDOWS\SYSTEM subdirectory.

* These files are the most likely files to be used by other programs.  

** SHARE.EXE is provided by the latest versions of  DOS and Windows.  If VSHARE.386 is available, it should be used instead of SHARE.  VSHARE.386 is available free from Microsoft.
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Introduction

	The names of the various IAQ models were selected to reflect the calculations they perform.  INDOOR calculated indoor concentration, EXPOSURE calculated exposure, and RISK calculates risk. \definition "indoor air quality" 
	RISK is the third in a series of indoor air quality  (IAQ) models developed by the Indoor Environment Management Branch of  U. S. EPA’s National Risk Management Research Laboratory.  The first model, INDOOR, was designed to calculate the indoor pollutant concentrations from indoor sources.  The second model, EXPOSURE, extended INDOOR to allow calculation of individual exposure.  RISK extends EXPOSURE to allow analysis of individual risk to indoor pollutant sources.  The three models were all developed as tools to carry out the mission of the engineering portion of the EPA’s indoor air research program “To provide tools necessary to reduce individual exposure and risk to indoor air pollutants.”  


The three models reflect the status of EPA source \Relate "THEOR2.DOC!15", "source"  and sink \Relate "THEOR3.DOC!14", "sink"  characterization research at the time the models were written.  RISK includes new empirical source \Relate "THEOR2.DOC!11", "empirical source"  models and mass-transfer-based source models in addition to the common first order decay \Relate "THEOR2.DOC!0", "first order decay"  source models used in previous models.  The mass-transfer-based \Relate "THEOR2.DOC!21", "mass-transfer-based"  source models are particularly useful for gas-phase-limited \Relate "THEOR2.DOC!33", " gas-phase-limited"  mass-transfer situations.

RISK is the first version of the IAQ model designed for the Windows operating environment.  Most of the material in this manual is contained in the on-line help file provided with RISK.

Purpose of IAQ engineering modeling research program

	Mission of IAQ engineering program: Develop cost-effective tools, techniques, technologies, and guidance necessary to prevent or reduce individual exposure to indoor air pollutants. \definition "mission of IAQ engineering" 
	The modeling component of the IAQ engineering research program is designed to support the overall mission of IAQ engineering research.  In meeting this mission the IAQ modeling program:

· Provides tools to integrate the results of IAQ research.

· Provides tools for analysis of the effects of IAQ control options on individual exposure \Relate "THEOR6.DOC!1", "individual exposure" .

· Provides tools for improving understanding of interactions of sources \Relate "THEOR2.DOC!15", "sources" , sinks \Relate "THEOR3.DOC!14", "sinks" , ventilation \Relate "THEOR4.DOC!2", "ventilation" , building parameters, air cleaners \Relate "THEOR5.DOC!3", "air cleaners" , and individual activity patterns \Relate "THEOR6.DOC!4", "activity patterns"  on individual exposure to indoor air pollutants.


Relationship between modeling and source characterization

The role of the model relative to source characterization can be seen from Figure 1.
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Figure 1. Risk analysis process.

Data related to source characterization are developed as part of EPA's indoor air source characterization program.  These data are used to develop source emission models that are used in this IAQ model.  The source models are updated whenever new information is developed by the source characterization research program.

Model overview

Introduction

RISK is designed using the concepts of buildings \Relate "OVER.DOC!9", "buildings"  and scenarios \Relate "OVER.DOC!10", "scenarios" .  The fixed information about a building, the number of rooms, the room dimensions \Relate "UM3.DOC!13", "room dimensions" , and the arrangement of the rooms is contained in a building file.  The changing information; sources, sinks, air exchange, room-to-room flows, etc. is contained in scenario files.  The steps in using the model are 

1. define the building, 

2. save the building information to a file, 

3. define the scenario, 

4. save the scenario to disk, 

5. and run the model.  

Repeat the scenario definition model execution process for each scenario of interest. 

RISK provides a wide range of graphical and tabular output of the results of the calculations.  Summary output of risk and exposure are provided in tabular form.  Full risk, exposure, and concentration output are also provided in tabular form.  The tabular output is supplemented by graphs of concentration and exposure versus time.  The calculated results can also be saved to disk for later analysis.

Building

In model terms a building is a collection of rooms and their interconnections. Room dimensions and room-to-room interconnections, but not room-to-room air flows, are fixed for a given building.  The actual values of room-to-room air flow and air flow between the building and the outdoors can be changed for the various scenarios.  A building may have an unlimited number of scenarios associated with it.

Scenario

In model terms a scenario is a collection of data for a given building that can change from model run to model run.  All information on sources, sinks, air flow rates, individual activity patterns, type of pollutant, and risk factors is included in the scenario.  

Data input

Data are entered into the model using a "fill in the form" interface.  The data in the form are not available for use by the program until they are "transferred" from the data entry form to the model.   Data are transferred from the data entry form to the model by selection the transfer command from the file sub-menu, or by clicking on the transfer button provided with the various data entry screens.

Model output

Graphs

The model can display the results of the various calculations in several graphs.  The graphs are:

· Concentration versus time

· Instantaneous exposure versus time

· Cumulative exposure versus time

· Bar chart of total exposure for each activity pattern

· Bar chart of time exposed to irritant concentration for each activity pattern

Most of the graphs can be displayed in the following formats:

· Linear x linear y

· Log x linear y

· Linear x log y

· Log x log y

All graphs can be printed.

Tables

In addition to the graphs, the model provides numerous tables displaying the results of the calculations.  The tables include:

· Summary table showing time exposed to irritant concentration, total exposure, and risk.

· Concentration versus time table.

· Exposure versus time table.

· Concentration and exposure versus time table.

· Summary risk table.

· Risk analysis table.

Data in the output tables may be copied to the Windows clipboard and pasted into other Windows applications.  This is a convenient way to enter data into a graphics package for plotting.

Files

The results of the calculations can be saved to a disk file.  This file is a Tab delimited file that can be read by many spreadsheet and graphics packages.

Model assumptions

The model is based on two assumptions:

1. All rooms in a building are well mixed. 

2. Mass is conserved.

Assumption 1 means that the concentration leaving the room through all exits is the same as the concentration in the room.  Numerous experiments in EPA's IAQ test house (Sparks, 1991) show that this assumption is valid.

The assumption that the rooms in a building are well mixed does not mean that the building is well mixed.  Individual rooms in a building may have different concentrations.

A room in the model does not always equal a room in the physical building.  For example, a single large room may need to be divided into two or more model rooms to meet the well mixed assumption.  And several physical rooms may be treated as a single room in the model.  

Assumption 2 means that the amount of air entering a room must equal the amount of air leaving the room.  This assumption also means that the amount of outdoor air entering the building as a whole must equal the amount of air leaving the building for the outdoors.   The model will warn the user if the mass balances are incorrect.  However, the model will not balance the flows for the user.  The user is responsible for ensuring that the flows balance.

Modeling decisions

Several decisions were made in designing the model.  Some of the major decisions were:

· The emphasis of  the effort was on model ease of use.

· The data requirements were minimized as much as possible.

· Data defaults would be provided as much as possible.

· Results of ongoing source and sink research would be incorporated into the model as soon as possible.

· User would be responsible for balancing flows.

· Room-to-room flows and ventilation rates were model inputs and would not be calculated from pressure/temperature data.

Most of these decisions were made to make the model easier to use.  The requirement that the user balance the flows was designed to help the user understand the input data.   The computer will determine if the flows balance, but it will not actually balance them.  The purpose of this decision is to reinforce the idea that mass must be conserved.  The user must determine where air is coming from and where it goes.

Model limitations

There are two types of limitations on the model:


· Data limitations

· User limitations

Data limitations

Data limitations are limitations about our understanding of  the processes occurring and imperfect scientific knowledge.  The major data limitations are:

· Limited data on source emission rates.

· Limited understanding of sinks and inadequate models for sinks.

· Limited risk information.

· Limited library of default data for room-to-room flows, ventilation rates, etc.

Research is underway to correct each of these data limitations.  The results of the research will be incorporated into the model as soon as they are ready.

User limitations

User limitations fall into four broad categories

· User does not understand what the model can do

· User does not understand or know what question the model should address

· The user does not fully understand the input data requirements

· The user does not understand the model output.

Often these limitations interact with each other and result in failure of the model to meet the user's needs.

These limitations often reinforce limitations caused by data gaps.

Organization of manual

The manual is organized into five parts:

· This overview.  

· Installation instructions.

· A user manual that explains how to run the model.  The various model menus and forms used in the model are discussed.

· A tutorial with several examples that demonstrate various model capabilities.

· The theory behind the model.

Support

Support for the model is provided on an "as time is available" basis.  Report bugs and problems to L. E. Sparks, U. S. EPA,  National Risk Management Research Laboratory, Air Pollution Prevention and Control Division, Indoor Environment Management Branch, MD-54, Research Triangle Park, NC 27711.  Suggestions for improving the model are welcome.

Be sure to read the READ.ME file on the distribution disk for information on the model that was developed after the manual was written.  The READ.ME file contains the latest information on bugs, bug fixes, source and sink results, and other important information.

One final note about the model.  The answer supplied by the model is only as good as the data input.  This is especially true of risk estimates as the following paragraph indicates.

Risk estimates based on currently available data are projections containing a great deal of uncertainty.  This is particularly true when using a model such as this one to calculate risk estimates for individuals, because such numbers as carcinogenic potency, upon which the model depends for calculating individual and population cancer risk, are projections of population risks based upon a variety of extrapolations and assumptions.  Risk estimates generated by models such as this one are useful mainly for the purposes of comparing scenarios rather than for determining absolute risks to individuals or populations
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Section structure

This section is structured as follows:

· An  overview of the user interface elements and common menu \Relate "UMP1.DOC!6", "menu"  items .

· A discussion of each major form and menu item used by the program.

Each of the major forms used by the program is discussed in a separate chapter.  The  main menu commands for each form are shown as section heading with the short cut key underlined. (Section structure above is a section heading.)  For example the heading for the file \Relate "UMP1.DOC!5", "file"  menu item is shown as: File.  The headings for discussion of sub-menu commands are indented and are shown as bold  with the short cut key underlined.  For example, the heading for the discussion of the New \Relate "UMP1.DOC!9", "New"  sub-menu command under the file menu is shown as: New.  The heading for the discussion of commands under the sub-menu is shown as bold italic with the short cut key underlined.  For example the discussion of printer setup found under the File Print \Relate "UMP1.DOC!10", "Print"  sub-menu is Printer Setup.

Overview of user interface

RISK is designed as a menu-driven, fill-in a form program. Menus are used to select actions, such as display a form or begin calculations, and forms are used for data entry and display.  The program also uses normal Windows controls such as push buttons and dialog boxes for some user interactions.  For example, push buttons are used to close most data entry forms and to transfer \Relate "UMP1.DOC!16", "transfer"  the data for use in the program.  Dialog boxes are used for file selection and printer control.

The program follows standard Microsoft Windows conventions for selecting menu items.  Menu items can be selected  with  the mouse or the keyboard.   For example, all menu items can be selected by pressing the Alt key and a letter key.  The letter key to press is underlined in the menu.  For example, the File item in all menus is shown as File.  Thus the file item can be selected by pressing Alt F.  An item can also be selected by placing the mouse pointer over the item and clicking the left mouse button.  For example, the file item can be selected by placing the mouse pointer over any part of the word File and clicking the left mouse button.

  General instructions

This section provides a brief discussion of the common user interface items. The user interface items discussed in this section are common to most of the forms used by the program.

Menus

With the exception of the display when the program is calculating, all the screens displayed by RISK contain a menu at the top of the screen.  The menu is used to control the actions taken by the program.  Possible actions include:

· Display  a dialog box 

· Display  another menu

· Display  a data entry form

· Transfer  control from one region of the program to another

· Begin calculations

· Display help

· Save data to disk

· Recall data from disk

· Print data on a printer.

Most menus provide only a few of these options. 

When a menu item is selected, a sub-menu of possible actions is often displayed.  For example, when the file item is selected, a sub-menu offering options to open \Relate "MENUS.DOC!3", "open"  a disk file, save \Relate "MENUS.DOC!4", "save"  data to disk, and perhaps other possibilities is displayed.  Items are selected from the sub-menu by clicking on the item with the mouse or by pressing the appropriate key on the keyboard. 

 Data entry forms

Data are entered into the program by filling in data entry forms.  These forms operate like small spreadsheets.  The left and right arrow keys allow movement between columns and the up and down arrow keys allow movement between rows.  The mouse can also be used to move from one cell in the form to another cell.  Data entry can be terminated by pressing the Enter key or by moving to a new cell with the arrow keys or the mouse.

Data entered into a data entry form are not immediately available to the program.  The data must be "transferred" from the data entry form to the program.  Most forms provide two push buttons labeled Transfer \Relate "UMP1.DOC!16", "Transfer"  and Cancel \Relate "UMP1.DOC!17", "Cancel" .  The Transfer button is used to transfer the data to the program.  Once the Transfer button is pressed, all previous data are overwritten.  The Cancel button aborts the data entry for the form.  Transfer and Cancel are also available under the File sub-menu found on all data entry forms.

When the Cancel button is pressed, control is returned to the form that called the data entry form and No data are transferred to the program.  All data entered into the form are lost when the Cancel button is pressed.

Most data entry forms allow data pertinent to the form to be stored on disk or to be read into the form from a disk file.  Most data entry forms also allow data to be copied from one cell to another using copy \Relate "UMP1.DOC!0", "copy"  and paste \Relate "UMP1.DOC!1", "paste"  options found under the Edit \Relate "UMP1.DOC!2", "Edit"  item in the form menu.

Entering new data into a cell erases the data previously in the cell.  

The  common buttons and common menu commands are discussed below.  This discussion provides general information on the purpose of the common menu items.  The exact actions of the various items depend on the context of the form the menu item is on.  For detailed information on the action of a given menu item on a given form consult the chapter where the form is discussed.

Buttons

	Transfer and Cancel are also provided under the File menu item. \definition "Transfer and Cancel" 
	The most common buttons are Transfer and Cancel.  These buttons appear on most data entry forms


Cancel

The cancel button unloads the current data entry form and returns control to the form that loaded the current form.  Cancel does not change the data available to the program.  All changes entered into the data entry form are lost.

Transfer

Transfer transfers data from the current form to the program.  Data values used by the program are changed to those shown in the data entry form.  Control is then returned to the form that loaded the current form.

Stop calculations

This button, found only on the screen displaying the progress of the concentration time calculation, stops the current calculation and returns control to the building form. 

Menu commands

The common menu commands are presented below.  The main menu commands are shown in bold with the short cut key underlined.  The sub-menu commands are shown in bold italic with the short cut key underlined.  Menu commands are arranged in alphabetic order.  The sub-menu commands under the menu commands are also in alphabetic order.  Menu items are selected by clicking on the menu item with the mouse, or by pressing the Alt and the short cut keys at the same time.  This is shown in the manual as Alt short cut key.  For example, the key combination for the file menu is Alt F.  Sub-menu items cannot be selected until after the main menu item is selected.  The steps in selecting a sub-menu item are:

1. Select the main menu item by clicking on it with the mouse or by using the Alt short cut key combination.

2. Select the sub-menu item by clicking on it with the mouse or by pressing the short cut key. 

Calculate

The Calculate menu item allows selection of the item to be calculated.  The Calculate item is selected by clicking on Calculate, or by the key combination Alt C.

Display

The Display item allows display of calculated results.  The Display item is selected by clicking on Display, or by the key combination Alt D.

Edit

The Edit menu item is provided as part of the menu for most data entry and data display forms.  The Edit item provides access to commands for copying data, pasting data, inserting and deleting blanks rows, and deleting data from a cell.  The Edit item is selected by clicking on Edit with the mouse or by the key combination Alt E.  The sub-menu items commonly found under the edit menu item are:

Copy

The Copy option is provided to copy from a form to the Windows clipboard.  The data in the form remain intact.  The difference between Cut and Copy is that when Cut is selected the data are removed from the form and when Copy is selected the data remain in the form.  Copy can be used to replicate data from a single cell or a range of cells.  A range of cells can be selected using the Mouse or the keyboard.  The Copy option is selected by clicking on Copy or with the key combinations Alt E (to display the Edit menu) followed by C.

Cut
The Cut option is provided to cut data from a form to the Windows clipboard.  The data are removed from the form.  Once the data are in the Windows clipboard, they can be pasted into another application using that application's Edit command.  Cut can be used to cut data from a single cell or a range of cells.  A range of cells can be selected using the Mouse or the keyboard.  The Cut option is selected by clicking on Cut or with the key combinations Alt E (to display the Edit menu) followed by U.

Paste
The Paste option is provided to paste data from the Windows Clipboard into a form.  The data being pasted may come form another cell in the same form or from a different application.  The Paste option is selected by clicking on Paste with the mouse or with the key combination Alt E (to display the Edit menu) followed by P.

File

Most menus have a File item.  The File item is the left most item in all menus.  The File item provides access to commands to load a new form, save data to disk, to open a disk file, to print data, and to exit the program.  The File item is selected by pressing the Alt key and F at the same time.  This key combination is shown as Alt F in the documentation.  Some of the common sub-menu items found under the File menu item are:

Cancel

The Cancel option is provided in all data entry forms.  Cancel cancels data entry and does not transfer data to the program for use in the calculations.  Cancel is selected with the mouse or by the key combination Atl F (to display the File menu) followed by C.

Close
Some menus associated with the display of calculated results provide a Close option.  The Close option closes the on screen form and returns control to the previous form.  Close is selected with the mouse or by the key combination Alt F (to display the File menu) followed by C.  Note that no menu contains both the Cancel and the Close option.

Exit
The Exit option is provided to exit the program and to return to Windows.  The Exit option is selected with the mouse or the key combination Alt F (to display the File menu) followed by X.  Exit can also be selected with the key combination Ctrl X.

New
The New option is provided for the Building menu and the Scenario menu.  When New is selected, all existing information for the Building (if New is selected from the Building menu) or the Scenario (if New is selected from the Scenario menu) is cleared.  New is selected with the mouse or the key combination Alt F (to display the File menu) followed by N.

Open
The Open option is provided to open a disk file and read the data from the file into the program.  When the Open option is selected, a file open dialog box is opened.  The file dialog box allows selection of the disk file to open.  Open is selected with the mouse or by the key combination Alt F (to display the File menu) followed by  O.

Print
The Pint option is provided to print data to a printer.  Often the Print option leads to another sub-menu that allows selection of the data to be printed.  The Print option is selected with the mouse or the key combination Alt F (to display the File menu) followed by P.

Save
The Save option is provided to save data to a disk file.    When the Save option is selected, a file save dialog box is opened.  The file dialog box allows selection of the disk file where the data are to be saved.  Data can be saved to an existing file (existing data are overwritten) or to a new file. Save is selected with the mouse or by the key combination Alt F (to display the File menu) followed by S.  

Transfer
The Transfer option is provided on all data entry forms.   Transfer transfers data from the data entry screen to the program for use in calculations.  Transfer is selected with the mouse or by the key combination Alt F (to display the File menu) followed by T.

Help

Help is the last item in all menus.  When Help is selected, the on line help file is loaded and control is passed to the Windows help system.  All of this manual is available as part of the on line help system.  Help is selected with the mouse or with the key combination Alt H.

Plot

This item provides access to the plotting functions of the program.  Plot is  selected with the mouse or with the key combination Alt P.

Rooms

The building definition form menu and the scenario form menu have a Rooms item.  The Rooms item for the building \Relate "OVERVIEW.DOC!9", " building"  definition form provides access to the forms used to enter room dimensions and define room-to-room connections.

The Rooms item for the scenario \Relate "OVERVIEW.DOC!10", "scenario"  definition form provides access to forms for entering data on in-room sources \Relate "SOURCES.DOC!11", " sources" , sinks \Relate "SINKS.DOC!12", "sinks" , and air cleaners \Relate "AIRCLEAN.DOC!13", " air cleaners" .  Rooms is selected with the mouse or the key combination Alt R.

Scenario

The Scenario option loads the scenario data entry portion of the program and transfers control to scenario data entry.  Scenario is selected with the mouse or the key combination Alt S.

Tools

The Tools item is not provided for all menus.  When it is provided,  it leads to a sub-menu that provides the option of loading a simple four function calculator or of loading a units conversion calculator.  Tools is selected with the mouse or the key combination Alt T.

Window

The Window is used to select the active window.  When Window is selected, a sub-menu offering the options Cascade, Tile, and List windows are provided.  Window is selected by clicking on the word Window or with the key combination Alt W.

Initial screen

When the program is loaded, the screen shown in Figure 2 is displayed.  Pressing any key or clicking on the picture erases the screen and loads the program.  The text in the sign on screen shows the release date and the version number of the program.

The version number of the program and the date may be different than that shown in Figure 2.  The version number and date should be included in all bug reports.   Bug reports should include as much information as possible on the nature of the bug and the system configuration used to run the model.  The minimum data for a bug report are:

· Type of computer being used.

· Amount of memory.

· Operating system, e.g., Windows 3.1, Windows 95, or Windows for Work Groups 3.11

· Other programs multitasking with RISK.
· Exact wording of error message.

· Complete information on the building being simulated.

· Complete information on the scenario being simulated.

· Information on the screen at the time the error appeared.

If you report the bug by mail, be sure to include a disk (3.5”) with the building and scenario files.  
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Figure 2.  Sign on screen for RISK
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Introduction

The building definition form is the master control form for the program.  The menu items on this form control data entry, calculations, and display of results.  The form is loaded after the sign on screen.  The building definition form is shown in Figure 3.  

[image: image4.wmf]
Figure 3.  Building definition form.

Note that the data entered on the building definition form are immediately available for the program and do not have to be transferred.  This is the only exception to the rule that data on a data entry form must be transferred before they are available to the program.

Data items

Building name

The building name is any name to identify the building.  It can be any combination of letters and numbers.  The building name is not used by the program except as an identifier in print outs.

Comments

The comments line is provided to allow additional identifying information.

Number of rooms

The number of rooms in the simulated building.

Master file

	If you are working on a project with many scenarios, you may find it convenient to create a subdirectory for the project that contains all the building, scenario, and result files for the project. \definition "master file" 
	The master file is the starting point for the file names you want all the files associated with the building to have.  The program uses the master file name to suggest file names for the user.  For example, if the master file is TUTOR, then the program suggests that all scenario files be named TUTOR*.SEN where the * indicates unique identifiers to identify scenarios.  All temporary files created by the program use the master file name.  You do not have to use the master file to name the scenario and other files--but you will probably find it useful to use the master file name.


File

The file menu item provides access to commands to clear all data for a new building, to read and write building data to disk file, to print data, and to save results.  When the File menu item is selected (Alt F), the screen shown in Figure 4 is displayed.
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Figure 4. Screen showing file options.

New Building

If File New is selected (Alt F N), all data in the program are cleared and a new building definition form \Relate "USERM.DOC!18", "building definition form"  is loaded, Figure 3. 

Open Building

If File Open (Alt F O) is selected, the file open dialog box, Figure 5, is displayed.
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Figure 5.  File open dialog box.

The file to be opened can be selected by typing the file name in the File Name box or by selecting the file name from the list of file names displayed in the list box.  The sub-directory can be changed by selecting a new sub-directory from the list of directories.  The drive can be changed by clicking on the Drive list to display a list of drives and then selecting the desired drive from the list.  Note that if a new sub-directory is selected, all subsequent file operations are directed to that sub-directory.

After the file is opened, the building data are read from disk and entered into the program.  Program control is returned to the Building form, Figure 3.

Save Building

When save is selected (Alt F S), the file save dialog box, Figure 6, is displayed.  This dialog box is used to enter the file name for where the building data are to be saved.  The file name can be typed in the text box or it can be selected from the list of already saved building files.  Note that the list of saved building files is grayed to indicate that selecting a file name from the list will overwrite already saved information.

[image: image7.wmf]File name box


Figure 6.  File save dialog box.

Save Results

Save results is used after all calculations are completed. When save results is selected (Alt F R), a new sub-menu, shown in Figure 7 is displayed. 
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Figure 7.  Save results sub-menu.

Save Concentration

When Save concentration (Alt F R C) is selected, a file save dialog box is opened.  The file name for the concentration file can be typed into the text box or selected from the list of previously saved concentration results.  The concentration results are saved as an ASCII tab delimited file with the extension CON.

Save Exposure

When Save exposure (Alt F R E) is selected, a file save dialog box is opened.  The file name for the exposure file can be typed into the text box or selected from the list of previously saved exposure results.  The exposure results are saved as an ASCII tab delimited file with the extension EXP.

Save all Results

When save all results (Alt F R  R) is selected, a file save dialog box is opened.  The file name for the results file can be typed in the text box or selected from the list of previously saved results files.  The concentration and exposure results are saved in the same file with the extension RES.

Print

When print (Alt F P) is selected , the print sub-menus are displayed, Figure 8.
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Figure 8.  Print sub-menu for building form.

Printer setup

When Printer setup (Alt F P P) is selected, the printer dialog , Figure 9, is displayed.  Clicking on OK will print material on the default printer in the current orientation (landscape or portrait).  Clicking on Cancel will close the dialog box and return control to the building form.  Clicking on Setup will load the printer setup dialog box, Figure  10. 

The printer setup dialog box is used to select orientation and the printer to be used.  

[image: image10.wmf]
Figure 9.  Printer dialog box.

[image: image11.wmf]
Figure 10.  Printer setup dialog box.

Building data

When Print Building data (Alt F P B) is selected, the building data are printed on the printer selected from the printer dialog box or the Windows default printer.  The program offers the option of previewing the printed output on the screen.

Scenario data

When Print Scenario data (Alt F P S) is selected, the scenario data are printed on the printer selected from the printer dialog box or the Windows default printer.  The program offers the option of previewing the printed output on the screen.

All data

When Print All data (Alt F P A) is selected, the building and scenario data are printed on the printer selected from the printer dialog box or on the Windows default printer.  The program offers the option of previewing the printed output on the screen.

Exit

When Exit is selected (Alt F X or Ctl x), all forms used by the program are unloaded, all data are cleared, and control is returned to the Windows operating system.  All unsaved data and results are lost.

Before the program returns control to Windows, a message asking if all temporary files created by the program should be erased is displayed.  The normal answer is Yes.

Rooms

When the Rooms menu item is selected, the room definition data entry form is loaded.  This form is shown in Figure 11 and is discussed in the next chapter.

[image: image12.wmf]
Figure 11.  Room definition form.

This form is used to enter all the fixed data for the rooms in the building.  The menu commands are Edit \Relate "UMP1.DOC!2", "Edit" , Tools \Relate "TOOLS.DOC!25", "Tools" , Window, and Help \Relate "UMP1.DOC!7", "Help" .  Edit allows copy \Relate "UMP1.DOC!0", "copy" , cut \Relate "UMP1.DOC!14", "cut" , and paste \Relate "UMP1.DOC!1", "paste"  operations to simplify data entry.  Tools provides the option of loading a simple four function calculator \Relate "TOOLS.DOC!25", "calculator"  or of loading a units conversion \Relate "TOOLS.DOC!26", "units conversion"  calculator.  Windows displays a list of forms that are currently open.  The active form is shown with a check mark beside it.  A new form can be selected from the list by clicking on it.

Scenario

Selecting the scenario item from the Building form menu loads the Main scenario \Relate "UMP3.DOC!13", "Main scenario"  definition form shown in Figure 12.

[image: image13.png]Eile HVAC Flows Natural flows_Rooms Occupancy Risk Tools Window Help
Transfer | | Cancel
Building simulated A
Scenario Name
Comments
Overall ACH 0
Constant ACH? __|Y
Constant HVAC?
Ni years simulated | 0
Outdoor concentration | 0
Pollutant
itant concentration_| 0
Cancer Risk/ug/m3_| 0
Ni_Occupants |0
Long term options |0
Master File Temp





Figure 12.  Main scenario form.

Calculate

When calculate is selected (Alt C), the calculate sub-menu, Figure 13, is displayed.  

[image: image14.wmf]
Figure 13.  Calculate sub-menu from building definition form.

Air flows

When Air flows is selected (Alt C A), the program calculates the air flows between the outdoors and the indoors for each room based on the overall air exchange rate specified in the main scenario data form.

Concentration

When Concentration is selected (Alt C C), the program loads the calculation in progress form, Figure 14, and calculates the concentration time history for the scenario.  The calculation can be stopped at any time by clicking on the stop calculation button \Relate "UMP1.DOC!11", "the stop calculation button" .

[image: image15.wmf]
Figure 14.  Calculation in progress screen.

Exposure

When calculate exposure \Relate "THEORY4.DOC!27", "exposure"  (Alt C E) is selected, the exposure calculation sub-menu, Figure 15, is displayed.  This sub-menu allows calculation of exposure or inhalation exposure.  Inhalation exposure includes the effects of breathing rate and is useful for many indoor air situations.

[image: image16.wmf]
Figure 15.  Calculate exposure sub-menu.

Risk

When calculate risk (Alt C R) is selected, the program calculates the cancer risk for the scenario.

	The temporary files can be quite large and should normally be erased as soon as possible.  The temporary files are ASCII files that can be read by other programs. \definition "temporary files" 
	Calculate writes several temporary files to the hard disk.  These files store the calculated results for later use by the program.  The files have the extension .TMP for temporary files created during the concentration calculation and .CMP and .EMP for the temporary files created during the exposure calculations.  The program asks permission to delete these temporary files before it returns control to Windows.


Display

Display is used to control the on screen display of calculated results.  When display is selected (Alt D) the display sub-menu, Figure 16, is shown.

[image: image17.wmf]
Figure 16.  Display sub-menu from building form.

Summary

When summary is selected (Alt D S), the summary results form, Figure 17, is displayed on the screen. 

[image: image18.wmf]
Figure 17.  Summary results form.

Concentration

When display concentration (Alt D C) is selected, a table of concentration versus time is displayed.  Commands to Copy the information in the table to the Windows clipboard for use by other Windows programs are provided.  The time during which the concentration exceeds the irritant concentration are shown with a red background.

Exposure

When display Exposure (Alt D E) is selected, the exposure sub-menu is displayed, Figure 18.  This sub-menu provides control over which exposure, cumulative or instantaneous, is displayed.

[image: image19.wmf]
Figure 18.  Display exposure sub-menu.

Risk

When display Risk (Alt D R) is displayed, the display risk sub-menu, Figure 19, is displayed.  This sub-menu allows display of risk in several different formats.
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Figure 19.  Display risk sub-menu from building form.

Summary of risk

When display summary of risk (Alt D R S) is selected, a summary of the risk calculations is displayed.

Full risk display

When display full risk display (Alt D R F) is selected, the details of the risk calculation are displayed, Figure 20.
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Figure 20.  Full risk display.

The full risk display can also be used as a risk spreadsheet.  The full risk display is discussed in the risk display chapter.

Plot

When Plot is selected (Alt P) the plot sub-menu is displayed, Figure 21.

[image: image22.wmf]
Figure 21.  Plot sub-menu.

The Concentration plot is an x-y plot of the concentration versus time for the simulation.

Cumulative exposure is an x-y plot of the cumulative exposure for each of the activity patterns used in the simulation.

Instantaneous exposure is an x-y plot of the instantaneous exposure for each of the activity patterns.

Irritant risk is the concentration plot with a line added showing the irritant concentration.

Bar chart of irritant risk is a bar chart comparing the time each of the activity patterns is exposed to a concentration equal to or greater than the irritant concentration.

Bar chart of cumulative exposure is a bar chart comparing the total exposure for various activity patterns.

Options

When Options (Alt O) is selected, the options sub-menu, Figure 22, is displayed.  

​
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Figure 22.  Options sub-menu.

 Calculate options

When calculate options is selected, the calculate options dialog box, Figure 23, is displayed.

[image: image24.wmf]
Figure 23.  Calculate options dialog box.

Calculation step size is the step size for the numerical calculation.  The step size must be small enough to capture the behavior of the system.  For example, if the source is an aerosol spray product that is on for 0.05 hr., the step size must be smaller than 0.05. If the source is a first order decay source with a decay  constant of  4, the step size must be on the order of 0.1 to capture the behavior of the source.  The step size set here is the default step size for the calculations performed by the program.  A small step size is also necessary if ventilation rates and/or HVAC operating conditions are changing rapidly.

Step adjustment factor is used to increase the calculation step size to speed the calculations.  The program will automatically increase the step size by the step adjustment factor when the concentration changes slowly.  The program will automatically decrease the step size back to the default step size whenever a source is turned on or the status of the HVAC system changes.

Set max concentration

Set max concentration is used to set the maximum concentration for the calculation in progress plot.

Windows

When Windows is selected (Alt W), a drop down sub-menu is displayed, Figure 24.  The sub-menu provides options for displaying the various windows and for selecting the active window.  The Windows menu item is provided for most menus. Because the action of the Windows sub-menu is identical for all cases, the Windows command will be discussed in this section only.
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Figure 24.  Windows sub-menu.

Cascade

When cascade is selected, all of the open Windows are displayed in a cascade arrangement, Figure 25.  The active window is the front window.
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Figure 25.  Cascade arrangement of windows.

Tile

When tile is selected, all of the windows are displayed tiled, Figure 26.
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Figure 26.  Tiled arrangement of windows.

Note that the menu for the active window is displayed.

List windows

When List windows is selected, a list of all the open windows is displayed.  The active window is shown with a check mark.

Help

When Help is selected (Alt H), the Windows help system is activated and the help file for RISK is loaded.  Two help files are provided.  The first, and the one that is loaded by default, is a short help file.  This short help file provides help with the most common uses of RISK.  The file name for the short help file is RISK.HLP.

The second help file is the full manual.  The file name for the large help file is MANUAL.HLP.  The file MANUAL.HLP can be loaded into the Windows help system by first activating the Windows help system and then selecting File Open (Alt F O) from the Windows help system main menu.  The file open dialog box will be displayed.  Enter the name MANUAL.HLP into the filename box.

MANUAL.HLP can be made the default help file by renaming RISK.HLP to RISKH.HLP and then renaming MANUAL.HLP to RISK.HLP.  

MANUAL.HLP is a very large file.  It can be deleted to conserve disk space if desired.
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The room definition form is shown in Figure 27.  The room definition form is used to define the physical size of the rooms in the building and to define the interconnections, but not the air flow rates, between rooms.  Rooms that are interconnected are said to be neighbor \Relate "UMP3.DOC!12", "neighbor" s.  The number of neighbors is calculated by the program after the neighbors have been defined.

The Room ID is any identification that will help the user.  The various room dimensions are entered in meters.  Not all the dimensions need to be entered.  The program can be used to calculate any missing dimensions. 

[image: image28.wmf]
Figure 27.  Room definition form.

File

The file item in the room definition menu provides access to commands for printing the data on the form and transferring the data from the form to the program.

Printer setup

Printer setup loads the print dialog box for controlling the printer, see Figure 9 in the Building definition chapter.

Print

Print prints the contents of the form using the current Windows printer. 

Transfer

Transfer transfers the data on the form to the program for use in calculations.

Cancel

Cancel closes the room definition form and erases all data entered.  Data are not transferred to the program.

Edit

The edit item in the room definition menu provides access to copy, cut, and paste operations. 

Cut
Cut removes data from the form and places the data in the Windows clipboard.  The data in the clipboard can be pasted into another cell of the form or into another Windows application.  Cut deletes the selected data.

Copy

Copy places a copy of the data in the selected cell(s) and places it in the Windows clipboard.  Copy does not affect the selected data.

Paste

Paste places the data in the Windows clipboard into the selected cell(s).

The use of copy and paste can simplify data entry.  Dimensions for one room can be copied to another room.

Tools

	Note that the short cut keys are not case sensitive.  For example, tools can be selected by pressing the Alt, Shift, and O keys at the same time or by pressing the Alt and o keys at the same time. \definition "Alt o" 
	When Tools (Alt o) is selected, the tools sub-menu, Figure 28, is displayed.
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Figure 28.  Tools sub-menu.

Calculator \Relate "TOOLS.DOC!25", "Calculator" 
When calculator is selected (Alt o C), a simple four function calculator is loaded.  The calculator can be operated from the keyboard or with the mouse.  The results displayed by the calculator can be copied to the Windows clipboard and then pasted into any of the data entry forms.  The calculator is discussed in the tools chapter.

Units conversion \Relate "TOOLS.DOC!26", "Units conversion" 
When units conversion is selected (Alt o U), the units conversion calculator is loaded and displayed, Figure 29.  The units conversion calculator is discussed in the tools chapter.
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Figure 29.  Units conversion calculator.

The units conversion calculator can be closed by selecting File Close (Alt F C).

Window

Provides a list of the current windows and allows selection of the active window.

Help

Loads the Windows help system.

Calculate missing dimension button

The calculate missing dimensions button will calculate any missing dimensions.  If length, width, and height are entered, clicking on the button will calculate a new volume, even if a volume has already been entered.  The calculate missing dimensions routines make the following assumptions:

· If Volume is the only value entered, the room is assumed to by 2.44 m high with length equal to width.

· If length and width are entered, the room is assumed to be 2.44 m high.

· If volume and either length or width are entered, the room is assumed to be 2.44 m high.

· If volume and height are entered, the length is assumed to be the same as the width.

Define neighbors button 

The define neighbors button is used to define neighbors.  A room is considered to be a neighbor of another room if there is a direct air flow path between the rooms.  For example, rooms on a common hall are all neighbors of the hall, but not with each other.  The define neighbors screen is shown in Figure 30.
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Figure 30.  Define neighbors form.

The Is Neighbor? column shows whether or not two rooms are neighbors.  The status can be toggled between Yes and No by either clicking with the mouse or by pressing the Enter key.

Control is returned to the Room definition form \Relate "UMP3.DOC!13", "Room definition form"  by pressing Transfer \Relate "UMP1.DOC!16", "Transfer"  or Cancel \Relate "UMP1.DOC!17", "Cancel" .  Transfer will transfer all data to the program and return control to the room definition form.  Cancel will return control and not transfer data.  

 Seq D2HDocument \h \r7 Main scenario form

Data on main scenario form

The main scenario form is shown in Figure 12 which is repeated here.
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Figure 12. Main scenario form. ( (Figure repeated from earlier.)

Each of the data entry items is discussed below.

The Building simulated information comes from the building file. 

Scenario name is a user specified name to identify the scenario.  

Comments are any comments about the scenario.

Overall ACH is the overall air exchange rate.  This value can be overridden later if desired.

Constant ACH? Answer Y if the air exchange remains constant for the duration of the simulation.  Answer N if the air exchange changes during the simulation.  If this question is answered N, the user must provide the air exchange as a function of time in the Natural Ventilation data entry process.

Constant HVAC? Answer Y if the air flows through the HVAC system are constant for the duration of the simulation.  Answer N if the HVAC system flows change.  If this question is answered N, the user must provide HVAC flow as a function of time information as part of the HVAC flows data entry process.

Nr of years to simulate? Is the number of years that the model should simulate.  The table below provides conversion factors for various numbers of days to numbers of years.

Table 1.  Conversion factors between days, hours and years.

	Days
	Hours
	Number of  years

	1
	24
	0.0028

	7
	 189
	0.019

	30
	  720
	0.08

	60
	1440
	0.16

	90
	2160
	0.25

	180
	4320
	0.49

	270
	6480
	0.74

	365
	 8760
	1

	400
	9,600
	1.1

	500
	12,000
	1.4

	1000
	24,000
	2.8

	1500
	36,000
	4.1

	3000
	72,000
	4.2


 Outdoor concentration is the outdoor concentration of the pollutant of interest in mg/m3.

Pollutant is the name of the pollutant being simulated.

Irritant concentration is the minimum concentration necessary to produce an irritant response.

Cancer risk is the cancer risk of the pollutant.

Nr of occupants is the number of occupancy patterns to be simulated.  Current limits are 0 to 4.

Long term option \Relate "EXAM3A.DOC!32", "Long term option"  is used to calculate long term exposure and risk from short term calculations.  The valid entries are 0, 1, or 2.  The action of each options is:

0
No long term calculations.  Long term exposure is calculated for the time the scenario runs.

1
Long term exposure is calculated using the average concentration for the scenario.  This option is useful to assess the exposure from activities that repeat.  The exposure for one repetition is calculated and then that exposure is extrapolated to long term.

2
Long term exposure is calculated using the value of the individual room concentrations calculated for the last time period in the simulation.  This is useful to estimate the exposure from steady state or slowly decaying sources.

This option is provided to allow estimates of long term exposure and risk without the need to run the full simulation.  The long term exposure is calculated for each activity pattern using the occupant lifetime data entered as part of the activity pattern definition.

Master file name is picked up from the building definition data entry process. 

The various menu options for the main scenario form are discussed below.

File

File is selected to enter a new scenario, read a scenario file from disk, or save the current scenario to disk.  File also provides access to the command necessary to print scenario information.  When File is selected (Alt F) the file sub-menu is displayed.  This is shown in Figure 31.
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Figure 31.  File sub-menu for the main scenario form.

New scenario

Selecting New (Alt F N) clears all scenario information and displays a blank main scenario data from.  Select this option to define a scenario from scratch.

Open scenario

Selecting Open (Alt F O) loads the file open dialog box.  When file name is selected, Open then reads the disk files containing the information necessary to specify the scenario.  Note that all scenario files have the extension .SEN.

Save scenario

Selecting Save (Alt F S) loads the file save dialog box for specifying the file name used to save scenario data.  All scenario files are saved with the extension .SEN.

Print scenario data

Selecting Print scenario data (Alt F P) produces the Print sub-menu that allows selection of which items are to be printed.  The print sub-menu is shown in Figure 32.
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Figure 32.  Print sub-menu for the main scenario form.

Summary information

Prints a short summary of the data used in the scenario.

HVAC flows

Prints the HVAC flows used in the scenario.

Natural flows

Prints the natural flows used in the scenario.

Sources \Relate "THEORY2.DOC!15", "Sources" 
Prints the source data \Relate "UMP6.DOC!16", "source data"  for the scenario.

Sinks \Relate "THEORY3.DOC!14", "Sinks" 
Prints the sink data \Relate "UMP5.DOC!17", "sink data"  used in the scenario.

All

Prints all the scenario data.

Transfer

Transfers scenario data from the scenario data form to the program.

Cancel

Clears scenario data entry forms and returns control to the building definition form.  Scenario data are not transferred for use by the program.  

Note Transfer and Cancel are also available as buttons.

HVAC Flows

When the HVAC flows item is selected (Alt H), the drop down sub-menu shown in Figure 33 is displayed.
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Figure 33.  HVAC sub-menu from main scenario form.

Air cleaner

Air cleaner \Relate "THEORY6.DOC!13", "Air cleaner"  is used to load the air cleaner definition form, Figure 34.
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Figure 34.  HVAC air cleaner definition form.

This form is used to define important air cleaner parameters.  The efficiency is the percent of material removed.  The capacity of the air cleaners depends on the nature of the air cleaner.  For example, capacity for a particle filter might be the maximum amount of particles collected before air cleaner pressure drop is excessive.  For a VOC air cleaner, capacity might be the amount of VOC collected before breakthrough.  The model assumes that the air cleaner has the specified efficiency until the amount of material collected by the air cleaner equals the capacity.  When this happens, the air cleaner efficiency drops to zero.  Note that the efficiency entered in this form is for the specific pollutant being modeled.

Flows (base flows)

Allows entry of the HVAC flows into and out of each room.  If the HVAC flows are constant, these flows are used for the entire simulation.  If the HVAC flows are not constant, these flows are modified as specified in the variable HVAC flows form.

The data entry form used to enter the HVAC flows is shown in Figure 35.
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Figure 35.  Data entry form for entering HVAC flow data.

In the model supply refers to all flows from the HVAC system to a space.  This means that all flows from the HVAC to the outdoors are listed as supply.  Return is defined as all air from a space to the HVAC system.  This means that air entering the HVAC directly from the outdoors is defined as return.  Exhaust is defined as mechanically driven or HVAC driven flows from a room to the outdoors.   Remember that air flow directly from the HVAC to the outdoors is listed under supply. 

Variable HVAC flows

Variable HVAC flows is used to enter information necessary to modify the HVAC flows during the simulation run.  HVAC flows are modified by multiplying the base HVAC flows \Relate "UMP4.DOC!18", "base HVAC flows"  entered using Figure 35 by a factor that can range from zero to any positive number.  The form used for entering these data is shown in Figure 36.

The HVAC flow history can be defined as a cycle.  If the HVAC flow history is not a  cycle, the HVAC flow for the last time entered is used for the rest of the simulation.  Note that the HVAC flow modifier modifies the HVAC flows and the HVAC driven room to room flows.
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Figure 36.  Form for entering HVAC flow modifiers.

Room-to-room flows

The room-to-room flows form is used to enter the HVAC driven room-to-room air flows.  The room-to-room HVAC flows are those flows necessary to maintain the balance for the HVAC system.  For example, in many homes every room has one or more supply registers, but there is only one return register.  In order to maintain a flow balance for the HVAC system, there must be flows from all the rooms to the return register.  These are defined as HVAC driven room-to-room flows.  The form for entering room-to-room flows is shown in Figure 37.
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Figure 37.  Data entry form for entering HVAC driven room-to-room air flows.

	 A spin control,, 

, is used in several other situations where data for individual rooms must be entered. \definition "spin control" 
	The spin control is used to change the room for data entry. 


When data for all the rooms are entered, click on Transfer \Relate "UMP1.DOC!16", "Transfer"  to transfer the data to the program.

The File menu item provides access to commands for printing the room-to-room air flows.  The File menu item also provides access to the transfer and cancel commands.

The Edit menu item provides access to the common edit commands, Copy, Cut, and Paste.

Natural flows

When Natural flows (Alt N) is selected, the drop down menu shown in Figure 38 is displayed.
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Figure 38.  Natural air flows sub- menu.

Outdoor flows

Outdoor flows loads the outdoor flows form. The form is shown in Figure 39.  This form is used to enter the outdoor air entering and leaving each room.  Data entered here can override the value entered for overall air exchange rate in the main scenario data entry form.  If the Calculate air flows menu item is selected from the Building form \Relate "UMP2.DOC!28", "Building form"  (see Figure 10), all data in this form are replaced by a value calculated by assuming that the overall ventilation rate holds for each room.  
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Figure 39.  Outdoor air flows data entry form.

Variable outdoor air flows

Variable outdoor air flows is used to enter the time history of the overall ventilation rate.  The data are entered as overall ventilation rate.  The model assumes that the overall ventilation rate applies to each room.  The model also assumes that when the variable ventilation rate option is used, the outdoor air entering a room is exhausted from the same room.  The form is shown in Figure 40.
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Figure 40.  Variable outdoor air ventilation rate data entry form.

The outdoor air flow time history can be defined as a cycle.  If the outdoor air flow history is not defined as a cycle, the last ventilation rate is used for the balance of the simulation.

Room-to-room flows

Naturally driven room-to-room air flows can be defined.  Note that the naturally driven flows must balance independent of the HVAC driven flows.  Also note that even when the ventilation rate is not constant, the naturally driven outdoor flows are assumed to be constant.  The form is used in the same manner as the HVAC driven room-to-room data entry form.  The naturally driven room-to-room flow data entry form is shown in Figure 41.
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Figure 41.  Naturally driven room-to-room air flow data entry form.

Room

When the Room item in the main scenario menu is selected, a new form is loaded shown in Figure 42.
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Figure 42.  Scenario room data form.

This form is used to enter the number of sources \Relate "UMP6.DOC!16", "sources"  and sinks \Relate "UMP5.DOC!17", "sinks"  in each room and also to enter the efficiency and air flow rate for in-room air cleaners.  The in-room air cleaner flow rate is expressed in terms of room volumes per hour that are circulated through the in-room air cleaner.  The model assumes that there are no capacity limitations for in-room air cleaners. 

Data for sources and sinks are entered by selecting the source and sink menu items.  Data for sources and sinks can be entered in a room-by-room basis or all at once.  This form is discussed in detail in the chapter Scenario room data.

Occupancy

When occupancy is selected from the main scenario form, the occupant activity pattern data entry form, Figure 43, is displayed.
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Figure 43.  Data entry form for entering activity pattern data.

The lifetime is the number of years that long term exposure is based on.

Breathing rate is used to calculate inhalation exposure.  A reasonable value is 0.833 m3/h.  

Efficiency factor is used to calculate dose used in the risk calculations.  The value depends on the pollutant and exposure of interest.  For inhalation exposure 1 is a reasonable value.

Population size is used to estimate population risk from the individual risk calculations.  It is the number of individuals that have the activity pattern defined in the form.

The start time is used to enter the simulation time that the activity pattern is to start.  This allows the activity pattern to start at some time after the simulation starts.  The end time is used to enter a time that the activity ceases. 

Time enter is the activity pattern time that a person enters a space.  The first time enter is always zero.  Time leave is the time a person leaves the space.  Time leave should be greater than the time enter.  Location is the name of the space the person is in.  Location must be selected from the list of allowable locations.  The program automatically enters Room Nr. based on the name of the location.

To end data entry enter 0 for the time enter.  After all data are entered for one occupant, use the spin control to change to another occupant.  After all occupancy data are entered, click on the Transfer button.

The model assumes that the occupancy pattern is cyclic.  The cycle length is calculated by the computer during the calculation phase of the simulation.  If a cycle length has been calculated, it is shown in the cycle length block.

Risk

When Risk is selected, the risk data entry form is displayed, Figure 44.  This data entry form is used to enter data on risk.  File provides access to previously entered risk data.
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Figure 44.  Risk data entry form.

Tools

When Tools is selected, the tools sub-menu, Figure 45, is displayed.  
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Figure 45.  Tools sub-menu.

Calculator \Relate "TOOLS.DOC!25", "Calculator" 
Calculator loads a simple four function calculator.

Units conversion \Relate "TOOLS.DOC!26", "Units conversion" 
Units conversion loads a units conversion calculator that is discussed in the tools chapter.

 Seq D2HDocument \h \r8 Scenario room data form

Introduction

This form is used to enter the number of sources and sinks in each room and also to enter the efficiency and air flow rate for in-room air cleaners.  The in-room air cleaner flow rate is expressed in terms of number of room volumes per hour that are circulated through the in-room air cleaner.  The model assumes that there are no capacity limitations \Relate "THEORY6.DOC!19", "capacity limitations"  for in-room air cleaners. 

Data for sources and sinks are entered by selecting the source and sink menu items.  Data for sources and sinks can be entered in a room-by-room basis or all at once.  

The scenario room data form is shown in Figure 42, which is repeated here.
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Figure 42.  Scenario room data form.  (Figure repeated from earlier.)

File

When File is selected, the file sub-menu is displayed, Figure 46.
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Figure 46.  File sub-menu for scenario room data entry.

Print room data

Prints the information on the screen to the current Windows printer.

Transfer

Transfers the data entered on the form to the program.

Cancel

Cancels the data entry operation, unloads the form, and clears all data entered.

Source

When the source menu item is selected, the source drop down menu shown in Figure 47 is displayed.  General is used to enter source data  independent of where the sources are and Room is used to enter source data on a room-by-room basis.
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Figure 47.  Sources sub-menu for room scenario data entry.

General

	The source data base is a data base of emission parameters for various source models and is maintained independent of the RISKl. \definition "source data base" 
	When general is selected, the form shown in Figure 48 is displayed.  The File command can be used to read in a previously stored list of sources that is used to fill in the form.  This File command also provides access to the source data base. Edit provides normal Windows Copy \Relate "USERM.DOC!0", "Copy" , Cu \Relate "USERM.DOC!14", "Cu" t, and Paste \Relate "USERM.DOC!1", "Paste"  operations.
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Figure 48.  General source data entry form.

The source model \Relate "SOURCES.DOC!11", "source model"  type is selected by clicking on the Model type column.  With each click, one of the model types allowed by the program will be displayed.  When the desired source model type is displayed, enter the data necessary to define the model.   Data requirements for various source models \Relate "THEORY2.DOC!11", "source models"  are discussed in the chapter on the Source form and in the Source chapter in the theory section of the manual.

If a number of sources for a given room is specified in Figure 42, that information is reflected in this form.  Note, however, that the number of sources in a room is calculated based on the data in this form.  For example, if the number of sources in room 1 shown in Figure 42 is one, and data for two sources in Room 1 are entered in this form, the number of sources in Room 1 is corrected to two.

Room

If Room is selected, the source data are entered on a room-by-room basis.  The form for entering data is shown in Figure 49.  The spin control is used to select the room being displayed.  Note that the number of sources displayed for a room is the same as the number of sources specified in the general rooms form, Figure 42.  If the number of sources specified for a room in Figure 42 is zero, a message is displayed on the screen.   This form cannot be used to increase or decrease the number of sources in a room.  This form is discussed in the chapter on Source data entry.
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Figure 49.  Data entry form for entering source data on a room-by-room basis.

Sinks

When Sinks \Relate "THEORY3.DOC!12", " Sinks"  is selected, the sinks sub-menu, Figure 50, is displayed.    General is used to enter data for sinks regardless of the room the sink is located in and room is used to enter data on a room-by-room basis.
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Figure 50.   Sinks sub-menu.

General

When general is selected, the general sink data form, Figure 51, is displayed.  
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Figure 51.  General sinks data entry form.

Data entered on this form overrides sink data entered in other forms. 

The data necessary to define a sink are the two rate constants, ka and kd, and the sink area.  See the chapter on sinks \Relate "THEORY3.DOC!29", "sinks"  in the theory section of the manual for a discussion of the rate constants \Relate "THEORY3.DOC!29", "rate constants"  and the sink model. 

Rooms

When Rooms is selected, the sink data for the indicated room are shown, Figure 52.  Note that the number of sinks in a room cannot be changed from this form.  The number of sinks must be changed using Figure 42 or Figure 51.
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Figure 52.  Room sink data entry form.

 Seq D2HDocument \h \r9 Source room data form

Introduction

The source data entry form is used to define the sources in the model.  A source is defined by the source model, the parameters necessary to define a particular model, the source size, and the on/off cycles of the source.  The model allows up to 6 sources in a room.  Each source may be turned on and off 5 times.

	The source calculators are used to calculate source parameters from data. \definition "source calculators" 
	The room source data entry form menu provides access to the source database and the source calculators \Relate "UMP6A.DOC!20", "source calculators" .  The source data base is discussed in the appendix.


The form is shown in Figures 53 and 54.
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Figure 53.  Room source data entry form, part 1.
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Figure 54.  Room source data entry form, part 2.

Source data

General source identifiers

The first item on the source data form is the source number.  This is provided by the computer.  The next item is the source name.  This is any identifier that the user finds useful to identify the source.

Source models

The third item is the type of source model.  The model currently supports the following source models:

· Exponential decay models \Relate "THEORY2.DOC!30", "Exponential decay models"  up to third order.  These models are designated as R0k models.  The form of the model is:

R(t) = R0exp(-kt) + R1exp(-k1t) + R2exp(-k2t) 

   (1)


where R(t) is the emission rate at time t, R0 is first order constant,, k is the first order decay constant, R1 is the second order constant, k1 is the second order decay constant, R2 is the third order constant, and k2 is the third order decay constant.  The most common form of this model is the first order decay model where R0 is the emission rate at time t=0.  A source with a constant emission rate can be described by setting k = 0.

· Mass transfer \Relate "THEORY2.DOC!21", "Mass transfer"  model with up to two phases.    These models are designated as Mass Xfer models in the Model type block.  The form of the model is:


R(t) = k1[Cv0 M1 (t)/M1 - C] +   k2 [Cv0 M2(t)/M2 - C]
(2)

 
where k1 is a mass transfer coefficient, Cv0 is the saturation vapor pressure, M1(t) is the emittable mass for phase 1 left in the source at time t, M1 is the initial emittable mass in the source for phase 1, C is the in-room pollutant concentration, k2 is the mass transfer coefficient for phase 2, M2(t) is the emittable mass for phase 2 left in the source at time t, and M2 is the initial emittable mass for phase 2.

· Empirical model for latex paint.  This model is designated as paint.  The form of the model is


R(t) =  R0/(1 + a R0t)




(3)


where R0 is an empirical constant (not to be confused with R0 for the decay model) and a is an empirical constant.

· A second model for paint called paint2.  This model is a form of mass transfer model.  The model is given by




 
(4)

where k is the gas phase mass transfer coefficient, Cv0 is the initial vapor pressure, Mv(t) is the gas phase limited emittable mass left in the source at time t, Mv0 is the gas phase limited emittable mass at time 0,  C is the in room concentration,  MD0 is the initial emittable mass due to source phase mass transfer (MD0 = M0 - Mv0  where M0 is total emittable mass applied), and is an empirical factor

A model for calculating VOC emissions from showers  called Shower.  
· On/Off model. This model is for a steady state source that turns on when the concentration is less than a lower limit value and is turned off when the concentration exceeds an upper limit value.

The selection of the appropriate emission model depends on the data available.  The source data base provided with the model contains source models for the sources evaluated by the IAQ engineering research program and a few source models from the literature.  See the appendix, "Source data base" for additional information.

All of the emission rates are expressed in terms of mass per unit source.  The total emissions from the source in the simulation are given by multiplying the size \Relate "UMP6.DOC!22", "size"  of the source by the emission rate.

The appropriate model is selected by clicking on the column labeled "Source model."  With each click, a different source model is displayed.

Additional source emission models may be added to the model at a later date based on the results of ongoing research.  Information on these models will be found in the on-line help under sources.

Size

This is the size of the source.  The units depend on the units of the emission factor.  For many indoor situations the emissions are expressed as mg/m2-h and the source size has units of m2.  Emissions from combustion sources are usually expressed as mg/KJ and the appropriate source size is KJ.

Number of cycles

This is the number of times that the source is turned on.  The maximum is 5.  A source that is turned on once has one cycle.

Cyclic?

This is a feature that allows a source to be be turned on on a cycle. The cycles are D for daily, W for weekly, and M for monthly.

Time on

This is the time the source is turned on.

Time off

This is the time the source is turned off.  If the source is turned on and never turned off, time off should be set to a large number, e.g. 1 x 109.

File

The File menu item provides access to the source data base.  When the file menu item is selected, the file sub menu, Figure 55, is displayed.  

[image: image58.png]1AQ Model
ToolsWindow _Help

Calculate
Open source file
Save source file

Source data

Open source data base

 source information | 15 0ol o q

Transfer
Cancel
[ 3]
[ 3]





Figure 55.  File sub-menu for room source data entry form.

​Open source file

This opens a previous source file that has been saved from the room source data entry form.  This file includes all the source information for a previous source, its model, model parameters, size, and time on and time off information.

Save source file

Saves the information on the source to disk.

 ​Open source data base

The Open source data base item opens the source data base.  The source data base contains information on sources that can be copied into the room sources form.  The source data base is discussed in the source data base chapter of this manual.

Print source information

Print prints the source information.  The print out includes all the source information for a previous source, its model, model parameters, size, and time on and time off information.

Transfer

Transfer transfers data from the data entry screen to the program.

Cancel

Cancel closes the data entry form and erases all data entered.

Edit

The edit \Relate "USERM.DOC!2", "edit"  menu item provides access to the common edit commands Cut \Relate "USERM.DOC!14", "Cut" , Copy \Relate "USERM.DOC!0", "Copy" , and Paste \Relate "USERM.DOC!1", "Paste" .

Calculate

When the Calculate item is selected, the calculate sub-menu, Figure 56, is displayed.  The calculate options allow calculation of some of the source parameters required by the program. 
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Figure 56.  Calculate sub-menu for room source data entry form.

​R0k

When calculate R0k is selected, the R0k calculator is loaded, Figure 57.  This calculator performs a non-linear least squares calculation to calculate R0 and k from chamber data.  The data required are the chamber volume, air exchange rate, source size, and the concentration time history of the material leaving the chamber.  The use of the R0k source calculator is discussed in the chapter on the R0k calculator.

[image: image60.png]Calculate_Plot

Tools_Help

[ Environmental data

Chamber Volume m3

[ Time/Concentration data entry

1

Air exchange rate/h

ot [Time_[ConcentratlPredicted [Residual

Source Area m2

—

Estimated peak conc

Estimated time for peak

[ Results

RO [

[

Sum of squares

Neration # 1





Figure 57.  R0k source model calculator.

Mass transfer coefficient

When the mass transfer coefficient option is selected, the mass transfer calculator form, Figure 58, is displayed.  This calculator calculates the mass transfer coefficient for gas-phase-limited mass transfer using the correlation 

Nu = 0.33Re0.67




(5)

where Nu is the Nusselt number and Re is the Reynolds number, Sparks et al.(1995).  See the chapter on sources in the theory \Relate "THEORY2.DOC!23", "sources in the theory"  section of the manual for a discussion of the correlation.
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Figure 58.  Mass transfer coefficient calculation form.

The air velocity is the velocity over the source, normally 5 to 15 cm/s.  The diffusivity of the pollutant is the diffusivity of the pollutant in air.  A typical value of diffusivity for common VOCs is 0.03 m2/h.  Under most conditions the mass transfer coefficient ranges from 1 to 6 m/h. 

Tools

Displays the Tools sub-menu which provides access to a simple four function calculator \Relate "TOOLS.DOC!25", "calculator"  and to the units conversion \Relate "TOOLS.DOC!26", "units conversion"  calculator.  Both of these calculators are discussed in the tools chapter.

 Seq D2HDocument \h \r10 R0k  calculator

Introduction

The first order decay model of source emission rate is one of the most common empirical source models.  The model is given by Equation (6).


R(t) = R0e-kt 




(6)

where R(t) is the emission rate at time t, R0 is the initial emission rate (the emission rate at t = 0), and k the first order decay constant.  The parameters for the model can be determined from dynamic chamber testing of sources.  The concentration, c(t), leaving the chamber at any time t is given by






(7)

where A is the source area, N is the chamber air exchange rate, and V is the volume of the chamber.  Equation (7) can be fit to the concentration time history data from the chamber using non-linear curve fitting.  The non-linear curve fit routine used in RISK is based on a program developed by Guo(1989) for analyzing small chamber data.

The R0k calculator form

The R0k calculator form is shown in Figure 57 which is reproduced here.  The form provides an area for entering environmental data about the chamber and an area for entering the concentration time history.  Data can be read from a data file, entered from the keyboard, or pasted from the Windows clipboard.  The ability to paste data from the Windows clipboard is especially useful in transferring data from other programs for use by the R0k calculator.  Data in the R0k form can also be copied to the Windows clipboard for use by other programs.  This provides a convenient method for plotting data in a graphics package.
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Figure 57.  R0k source model calculator.(Figure repeated from earlier.) 

Chamber environmental data

Enter chamber environmental data by moving cursor into the box you want to enter data for and then typing in the data.  You can use the  mouse to move the cursor, or the tab key.  You can move from box to box with the tab key. 

You must enter the environmental data to calculate the source model constants.

Chamber concentration data

Enter the time concentration data in the grid.  Data entry is similar to data entry using a  spreadsheet.  

You can move from row to row using the up and down arrow keys.  Move from column to column using the left and right arrow keys.  When you have entered an item, you can either hit enter or one of  the arrow keys to complete data entry.

You can paste data from other Windows applications into the data entry form using the Paste \Relate "UMP1.DOC!1", "Paste"  command from the Edit menu.  You can also copy \Relate "UMP1.DOC!0", "copy"  and then paste data from the data entry form into other Windows applications.  For example you can paste the predicted and measured concentrations into a spreadsheet and use the spreadsheet to prepare high quality plots.

Calculate R0k

Calculate the first order decay constants, R0 and k  by clicking on Calculate and then on Calculate R0k.  Calculate predicted values of concentration by clicking on Calculate and then clicking on Predict.

R0k Calculator menu items

File

When File is selected from the menu, the file sub-menu is displayed, Figure 59.
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Figure 59.  File sub-menu for R0k calculator.

New

When New is selected, all data in the form is cleared without being saved.

Open

When Open is selected, a file open dialog box is opened.  This allows data from a previous run, or data from another application to be read into the data entry form.

Save

When Save is selected, a file save as dialog box is opened.  This allows data and results from a calculation to be saved in a disk file.

Edit

Cut

Cut cuts (removes) the selected information from the form and places the information in the Windows clipboard.  Information placed in the Windows clipboard can be pasted into any Windows program that supports the clipboard.

Copy

Copies the selected information from the form to the Windows clipboard.

Paste

Copies information from the Windows  clipboard to the form.  Paste is useful for copying information from another program, e.g. a spreadsheet, into the R0k calculation form.

Insert row

Inserts a blank row into the data entry form at the selected row.  Rows below the selection move down.

Delete row

Deletes the selected row.  Rows below the selected row move up.

Calculate

R0k

Calculates R0 and k from the data.

Predicted values

Calculates emission rates based on the fitted values of R0 and k.  The predicted values and residuals are placed in the data entry form.

Plot

Plot produces a graph of the data and the fitted values on the screen.

Tools

Loads the tools sub-menu.

Calculator \Relate "TOOLS.DOC!25", "Calculator" 
Loads and displays a simple four function calculator.  The calculator can be    operated using the mouse or the keyboard.  The use of the calculator is discussed in the chapter on tools.

Units conversion \Relate "TOOLS.DOC!26", "Units conversion" 
Loads and displays the units conversion calculator. The use of the units conversion calculator is discussed in the chapter on tools

 Seq D2HDocument \h \r11 Risk display

Introduction

	Note that risk estimates involve a great deal of uncertainty.  The risk estimates generated by RISK are useful mainly for the purposes of comparing scenarios rather than for determining the absolute risks to individuals or populations. \definition "risk calculations" 
	The risk framework proposed by Naugle and Pierson (1991) is used to display the results of the risk calculations  performed by the model. Risk is the last item that the model calculates.  Thus before the risk display is used, the user must calculate the concentration and exposure.  The risk display is shown in Figure 60.
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Figure 60. Risk framework displayed by model.

The display serves as a way to present the data from the model calculations and as a risk calculation spreadsheet.

Occupant name

The first column in the display is occupant name.  This is the identifying information assigned to the occupant as part of the occupancy data entry.  

Pollutant type of risk

The second column lists the pollutant of interest and the type of risk.  Three types of risk are presented as defaults.

· Irritant/non cancer risk.  This is the number of hours that the occupant is exposed to pollutant concentrations greater than the irritant concentration entered under scenario data.  The total exposure from being exposed to irritant concentrations is also presented.  Note that although this is the only non-cancer risk currently calculated by the model, there are other non-cancer risks due to poor IAQ.

· Cancer risk.  This is the cancer risk calculated for the length of time the scenario actually covered.  In many cases, this number is not of interest.

· Cancer risk lifetime.  This is the lifetime cancer risk based on the occupant lifetime entered as part of the occupant data entry and the exposure calculated from the long term exposure option. 

Determining which, if any, of these risk displays is meaningful is the user's responsibility.  

Concentration

This is the irritant concentration for irritant risk or the average concentration for cancer risk.

Duration

This is the length of time considered for the risk.  For irritant risk it is the time exposed to a concentration greater than the irritant concentration.

Exposure

Exposure is the time exposed to the pollutant multiplied by the concentration.  For cancer risk exposure is the average concentration times the duration.  Units of exposure are mgh/m3.

Conversion factor

The conversion factor, also called efficiency or dosimetry factor, is the conversion factor that converts exposure to dose.  The conversion factor can include factors such as fraction of pollutant reaching target organ or units conversion needed to convert exposure to exposure per kg of body weight.

Dose

Dose is efficiency times exposure.  Common units are mg.

Dose response

This is the relationship between dose and effect.

Individual risk

Individual risk is Dose times dose response.

Population 

The number of individuals represented by the activity pattern used to calculate individual risk.

Population risk

The risk to the entire population.  Population risk is Individual risk times Population.

Using display form as a risk calculator

The display form can be used as a risk spreadsheet calculator.  The concentration, duration, and exposure initially displayed on the risk display form are calculated by the program.

The user can enter data in any of the columns and the effects of that data on risk will be reflected in the lifetime individual risk.  If a number for population is entered in the population column, a population risk will be displayed.  

A common use of the risk calculator is to determine the affects of different dosimetry and response factors on the risk from the calculated exposure.  This is particularly useful when the literature provides a range of factors from different studies.

In order to use the calculator in this fashion, all that is necessary is to change the factors in the display to their new values and click the calculate button.  The new risks are displayed.

The risk spreadsheet can also be used to calculate risk due to exposure to some average concentration for a given time.  In this case all the data in the spreadsheet must be supplied.  Then click calculate.

For example, assume that the dose/response for cancer is 1 x 10-5 for the various occupants.  Enter 1 x 10-5 in the dose/response column for each of the occupants.  Then click on calculate, to calculate the new risk.  The results of the calculation are shown in Figure 61.
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Figure 61.  Example use of risk display as a risk calculator.

See the chapter on risk calculation \Relate "THEORY5.DOC!31", "risk calculation"  in the theory section of the manual for additional information.  Note that the calculation shown in Figure 61 is for purposes of illustrating the use of the risk calculator and does not represent any real pollutant.

 Seq D2HDocument \h \r13 Example 1--basics.

General

The quickest way to get started using RISK is to run several examples.  The tutorial provides several examples of using RISK and covers all the basics of data entry.  The building file for the tutorial is called TUTOR.BLD.  The various scenario files for the tutorial are TUTOR1.SEN, TUTOR2.SEN., ... TUTORn.SEN.

Building for tutorial

	Note that all the tutorial files are on the distribution disk. \definition "tutorial examples" 
	All of the tutorial examples use the same building.  The building is a four room building with the following characteristics.  The basic tutorial is based on modeling a four room residence with central air.  The room data are given in Table  3.


Table 3.  Building data for basic tutorial.

	Room ID
	Length m
	Width m
	Height m
	Volume m3

	Living Area
	 7
	 4
	 2.5
	 70

	Hall
	3
	1
	2.5
	7.5

	Bedroom
	 4
	3
	2.5
	30

	 Bathroom
	3
	2
	2.5
	15


A drawing for the building is given in Figure 69.  

All rooms  except the hall have an HVAC supply.  The only HVAC return is in the hall.  All the rooms are connected to the hall.   There is no HVAC supply in the hall. 
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Figure 69. Building for examples.

Run the model by clicking on the RISK icon.  The sign on screen is shown in Figure 70.
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Figure 70. Sign on screen for RISK.

Click on the picture or press any key to load the building definition form, Figure 71.  Note that this is the master control form for the program.

 Select File  then New building (Alt F N) to clear all data.    Note that the program provides a default of one room for number of rooms and TEMP as the master file name.  The master file name is used by the program to organize the various files that go with each building.  Fill in the form  by setting the number of rooms to 4 and the Master file name to Tutor.  The completed form is shown in Figure 72.  The building ID and comments sections are used to provide information useful to the user.  The information in these data fields is not used by the program.
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Figure 71.   New building data entry form.
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Figure 72.  Completed building information form for examples.

	Because the height is the same for all rooms, you can enter the height for room 1 and then use copy paste to copy the height to the rest of the rooms. \definition "Height" 
	Now enter the room data.  Select Rooms (ALT R).  Enter the dimensions Length, Width, and Height then press Calculate Missing Dimension.  The completed room data form is shown in Figure 73.
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Figure 73.    Completed room dimension form for examples.

Because all rooms are neighbors of the hall (room 2), the easiest way to define the neighbors is to move the cursor to room 2 and press the Define Neighbors button.  This will load the neighbors form.  When the neighbors form is loaded, move the cursor to Room 1 and press the left mouse button, then move the cursor to Room 3 and press the left mouse button, and finally move the cursor to Room 4 and press the Left mouse button.  The completed form is shown in Figure 74.  

[image: image71.png]|
<

Window _Help

BT —

Foon[foon 1D [is Neighbor?
1 [Lvingaen Tes
3 [Bedoom Yes
4 [pathioon Yes





Figure 74.    Completed list of neighbors form for basic tutorial.

Press the Transfer button to transfer the data from the data entry form to the program.  Control is returned to the Room data entry form shown in Figure 75.

[image: image72.wmf]
Figure 75.  Completed room data entry form.

Press the Transfer button to transfer the room data from the form to the program.  Control is returned to the main form.  

Select File Save building (Alt F S) and save the Building data.  The file save dialog box will be displayed.  Provide a file name for the building data file by filling in the dialog box.  The building data will be saved in the file with the given file name with the extension .BLD.

This completes the first step of data entry. This building will be used for all of the examples in this tutorial.  

Scenario data entry is the next step in the data entry process.  

Example 1. scenario

The scenario data are all data that can be expected to change from model run to model run.  These include data on air exchange with the outdoors, room-to-room air flow, source emission rates, and occupancy patterns.  The data for example 1:

Scenario data

Air exchange with the outdoors 0.5 ACH

The pollutant is VOC with an irritant concentration of  0.3 mg/m3.  There is no cancer risk.

The simulation will run for 0.01 years.  There is no desire to calculate long term exposure.

Source emissions described by empirical function  R = 1000e-0.4t where R is the emission rate in mg/m2-h and t is time in hours.

Source size is 10 m2.

Source is turned on at time t = 1 hr and turned off at 100 hrs.

There are no sinks.

Occupancy patterns are given in Table 4.

Table 4.  Occupancy patterns for Example 1.

	Person
	Time
	Location

	Person one
	24 hours/day
	Living area

	Person two
	0 to 8 hrs
	Living area

	
	8 to 16 hrs
	Outdoors

	
	16 to 24 hrs
	Bedroom


All room to room air flow is through the HVAC system.  Flows are given in Tables 5 and 6.

Table 5.  HVAC air flows for Example 1.

	Room
	HVAC Supply m3/h
	HVAC Return m3/h

	Living area
	350
	0

	Hall
	0
	575

	Bedroom
	200
	0

	Bathroom
	25
	0


Table 6.  Room-to-room air flows for Example 1.  All room-to-room air flows are driven by HVAC.

	Room
	Flow from Hall to Room
	Flow from Room to Hall

	Living area
	0
	350

	Bedroom
	0
	200

	Bathroom
	0
	25


There are no other room-to-room flows.

Entering general scenario data

Select scenario (Alt S) to load the scenario data entry form, Figure 76.
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Figure 76.  Scenario data entry form.

Fill in the Scenario data entry form.  The completed form is shown in Figure 77.  Make sure that the constant ventilation and constant HVAC are set to Y.  Note that long term options is set to zero.
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Figure 77.   Completed scenario form for Example 1.

Entering scenario HVAC data

Select HVAC  then select Flows (Alt H F) to enter HVAC flow data.  The HVAC flow form is shown in Figure 78.  Supply, as used in Figure 78, is all air from the HVAC system to a space.  Return is all air from a space, including the outdoors, to the HVAC.  Exhaust is the HVAC (mechanically) driven flow from a space to the outdoors.
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Figure 78.  HVAC base flows form.

Fill in the form.  The completed form is shown in Figure 79.
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     Figure 79.  Completed HVAC flows form for Example 1.

Now enter the room-to-room air flows.  Because the flows are driven  by the HVAC system, they must be entered using the HVAC menu.  Select HVAC Room-to-room flows (Alt  HR).  Because the only room-to-room air flows are from the other rooms to the hall (room 2), it is easier to enter all the room-to-room flow by selecting room 2.  To select room 2, use the spin up control to select room 2.  Now enter the Room-to-room flows for room 2 (the hall). The completed form is shown in Figure 80.
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Figure 80.  Room-to-room HVAC air flow data entry form.

Note that the flows balance.

Press Transfer to transfer the data from the data entry from to the program.  Control will be returned to the scenario menu.

Entering scenario source data

Now select Rooms (Alt R) to enter source data.  Assume the source is in Room 1 (the living area).  Enter the 1 for number of sources in  room 1.   The completed form is shown in Figure 81.
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Figure 81.  Scenario room data form for Example 1.

Select Sources then room (Alt S R) to call up the sources data entry form.  The blank sources data entry form is shown in Figure 82.  Note that this is a wide form and you may need to use the arrow keys at the bottom of the form to see some of the data entry columns.
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Figure 82.  Blank room sources data entry form.

Enter Example, in column one for the source Name.  Move to column 2 and click the left mouse button until the source model caption changes to R0k.  Move to column 3 and enter 1000 for R0, Move to column 4 and enter 0.4 for k, move to the column labeled Size and enter 10, move to the next column and enter 1 for number of cycles, move to the time on column (the next column) and enter 1 for time on.  Move to the time off column (the next column) and enter 100 for the time off.  The completed data entry form is shown in Figure 83.  
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Figure 83.  Completed source data entry form for Example 1.

Click on the Transfer button to transfer the source data to the program.  Control is returned to the rooms form.  Click on the transfer button to transfer all the room data to the program.  

Entering scenario occupancy data

Now enter the occupancy data by selecting Occupancy (Alt O).  The occupancy form is  shown in Figure 84.
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Figure 84.  Activity pattern data entry form.

For occupant 1 enter One for occupant name, move to the next row and enter 0.833 for the respiratory volume, move to the next row and enter 1 for efficiency.  Use the mouse or arrow keys to move the cursor to time enter and enter 0. Leave the lifetime at the default of 70.  Move to the Time leave column and enter 24.  Move the cursor to the location column.  Use the mouse to move the cursor to Living area in the List of possible locations and click the left mouse button.  Living area will appear in the Location column and 1 will appear in the room number column.  See Figure 85.
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Figure 85. Activity pattern data entry process for Example 1.

Now click on the spin up control to select the next occupant.  Enter Two for occupant name, 0.833 for respiratory volume, and 1 for efficiency. Enter 0 for Time Enter,  8 for Time Leave.  Click on living area.  Move the cursor to the next row.  Enter 8 for Time Enter, 16 for Time Leave, and click on Outdoors for location.  Move to the next row. Enter 16 for Time Enter, 24 for Time Leave, and click on Bedroom for location.  The completed data entry form for occupant two is shown in Figure 86.
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Figure 86.  Completed activity pattern data entry for occupant 2 in Example 1.

Click on Transfer to transfer data to program.  Control is returned to the main scenario screen.   Select File Save Scenario (Alt F S) to save the scenario data.  You will be asked to supply the file name.  Click on Transfer to transfer all of the scenario data to the program and return control to the main form.

Scenario calculations

Select Calculate Air Flows (Alt C A) to calculate air flow rates from the building to outdoors.  Then select Calculate Concentration (Alt C C) to calculate concentration.  A strip chart will display the concentration versus time for during the calculation.  See Figure 87.  If the flows were not entered properly, an error message saying that the flows were not balanced will be displayed after you select Calculate Concentration.  If you get this error message, re-enter the flows.  Then select Calculate Concentration (Alt C C).  You will get a message informing you that the concentrations were already calculated.  Select OK to continue your calculation. 

[image: image84.png]In room concentration

Ed

Total emitted

[25.420.44m |  Sink Mass

. mg

Time .7 days HVAC 1
Status

Leaving 24,444 98 mg Ventil 0.5
rate -

AveConc  [4.804 mg/m3





Figure 87.  Calculation in process display for Example 1.

After the calculations are complete, select Calculate Exposure (Alt C E) to calculate inhalation exposure.  Then select Calculate Risk (Alt C R) to calculate risk.

Scenario results

Select Plot Concentration (Alt P C) to plot the concentration time history.  The plot is shown in Figure 88.
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Figure 88.  Concentration versus time results for Example 1.

Select New Plot Cumulative Exposure (Alt N U).  The plot of cumulative exposure plot is shown in Figure 89.
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Figure 89.  Cumulative exposure for Example 1.

Close the plot (Alt F C) and return control to the main form. (You must close the plots one at a time.) Save the results of the calculations (Alt F R) to a file. (This will lead to the save results menu--Save Concentration, Save Exposure, and Save all Results.  Select Save all Results.)  The saved files are comma and tab delimited ASCII files that can be read into other applications for plotting and additional analysis.  

This completes Example 1.

 Seq D2HDocument \h \r14 Example 2--Sinks

Overview

The data used in this example are the same as those used in Example 1 except that a single sink is added to each room.  The results of this example are compared with those of the previous example to demonstrate the effects of sinks on concentration and exposure.

Example 2 data

The data for Example 2 are the same as for Example 1 except that a single sink is located in each room.  The sink data are given in Table 7.

Table 7.  Sink data for Example 2.

	Room ID
	Sink name
	Sink ka
	Sink kd
	Sink area m2

	Living Area
	 General
	0.1
	0.01
	 80

	Hall
	 General
	0.1
	0.01
	10

	Bedroom
	  General
	0.1
	0.01
	40

	 Bathroom
	 General
	0.1
	0.01
	2


Scenario data entry sinks

The sink data are entered by selecting Rooms (Alt R) from the scenario menu.  Then select Sinks General (Alt N G) from the Room menu.  The general sinks menu is displayed, see Figure 90.

Enter the data for room 1.  Note that as soon as you enter the room number, the room name is displayed.  The data entry form after room 1 data are entered is shown in Figure 91.
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Figure 90.  General sink data entry form.
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Figure 91.  Sink data entry for room 1, Example 2.

	Use the Edit copy/Edit Paste edit options to speed data entry for the sink data.  Highlight the first 3 columns (General, .1, and .01.  Select Edit Copy.  Highlight the first three columns for the remaining rooms and select Edit Paste.  This will paste General, .1, and .01 into the form. \definition "Efficient" 
	Enter the data for the other rooms.  For room 2, for example, enter General for sink name, 0.1 for ka, 0.01 for kd, and 2 for room number.  The completed sink data entry form is shown in Figure 92.  Sink data could also be entered using the Room option under the sink menu item.  The general sink data form is the most efficient way to enter sink data for this example.  Note that before the Room option under the sink menu is used, the number of sinks in each room must be specified in the room data form.  The number of sinks in a room cannot be changed using the Room option under the sink menu.
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Figure 92.  Completed sink data entry form for Example 2.

Transfer the sink data and return to the Room data form.  Note that the number of sinks in the room is automatically entered into the room data entry from.  The room data form after the sink data are entered is shown in Figure 93.
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Figure 93.  Scenario rooms data entry form after sink data for Example 2 have been entered.

Transfer the room data and return to the main scenario data entry form.  Change the time to run the simulation from 0.01 to 0.1 years.  Save the scenario data using File Save Scenario  (Alt F S).  You will be asked to provide a filename.   Then transfer the scenario data and return to the building data entry form.

Example 2 calculations

Select Calculate Concentration (Alt C  C) to calculate the concentration as a function of time.  An example of the strip chart for this example is shown in Figure 94.  Note that information on the amount of material in the sink, amout of material emitted, and amount of material leaving the building is displayed.  The average building concentration is also displayed.  The ventilation rate and the HVAC status are shown.  HVAC status is the fraction of the HVAC base case flows.  In this case the HVAC status is 1 indicating that the HVAC is operating at the base condition.
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Figure 94.  Calculation in progress screen for Example 2.

Example 2 results

When the calculations are completed, control is returned to the main building form.  Plot the results of the calculations (Alt PC).  The plot is shown in Figure 95.  

[image: image92.png]— 1AQ Model

isk

S

Edit_ Options _New plot_Window _Help

= Plot of Concentration

Concentration vs time

Consinmticn
imgizam)

S T 200 300 200

Tims (s

Room 1

Foom 2

Roor 3

Foom 4





Figure 95.  Concentration versus time plot for Example 2.

Change the plot to linear x log y using Options Scale Linear x log y (Alt O S 3).  The plot is shown in Figure 96.  Compare this plot with the plot for the case with no sinks, Figure 97.
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Figure 96. Linear time, log concentration plot for Example 2.

[image: image94.wmf]
Figure 97.  Log concentration linear time plot of no sink results.

Calculate exposure and risk.  After exposure and risk are calculated, display the summary results (Alt D S).  The summary form is shown in Figure 98.
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Figure 98.  Summary output for Example 2.

 Seq D2HDocument \h \r15 Example 3--variable flows

General

The data used for this example are the same as those used in Example 2 except that the HVAC air flows and the ventilation rate are allowed to vary.  Natural room-to-room air flows are used in this example in addition to the HVAC flows.

Example 3 data

The input data for Example 3 are the same as for Example 2 except that the HVAC flows and the ventilation rate are allowed to vary.  The HVAC flow schedule is shown in Table 8 and the ventilation rate schedule is shown in Table 9.  Both HVAC and ventilation flows are cycles.

Table 8.  HVAC air flows for Example 3.

	Time (hrs)
	Fraction of HVAC baseline flow

	0
	0

	8
	1

	20
	0

	24
	0


Because the HVAC flows are a 24 hour cycle, a full 24 hours must be described.  Thus the flow at the end of the cycle must be entered.

Table 9.  Ventilation rates for Example 3.

	Time Start (hrs)
	Ventilation rate (ACH)

	0
	.3

	6
	.4

	12
	.5

	18
	.4

	24
	.3


Entering scenario data: variable HVAC flows

Select the main scenario data form change the Constant HVAC and Constant ventilation to N.  The completed form is shown in Figure 99.
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Figure 99.  Main scenario form for Example 3.

The base HVAC flows are the same as used for Examples 1 and 2 and do not have to be entered.  Enter the HVAC flow schedule by selecting HVAC Flows Variable Flows (Alt HV).  Fill in the data entry form using the data from Table 8.  The completed form is shown in Figure 100. Press Transfer to transfer the data to the program.  
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Figure 100.  Completed variable HVAC form for Example 3.

Entering scenario data variable ventilation rates

Now enter the ventilation schedule for the natural flows (Alt N V).  Fill the form using the data from Table 9.  The completed form is shown in Figure 101.
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Figure 101.  Ventilation history form for Example 3.

Transfer the ventilation history data to the program.

This example includes the effects of natural room-to-room flows.  These flows are entered by selecting Natural flows Room-to-Room (Alt N R).  The complete form is shown in Figure 102.
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Figure 102.  Naturally driven room-to-room air flows for Example 3.

Transfer the naturally driven room-to-room air flows.

Save the scenario data.  Then transfer all the scenario data to the program.

Calculations for Example 3

Calculate concentrations.  The strip chart will show the changing ventilation and HVAC rates in the text windows.  See Figure 103.

[image: image100.png]L nroomconcenwaton ISR
Total emitted (25 458 34 m Sink Mass  [6.017.66 mg

i

i

ime 7 days HVAC g

i Y Status

Leaving  [20.813.91 mg Ventl 05
rate

AveConc  [3.256 mg/m3

Stop Calculation





Figure 103.  Calculation in progress screen for Example 3.

Calculate the exposure for Example 3.  

Example 3 results

The concentration versus time plot for Example 3 is shown in Figure 104.  Compare the results of this calculation with the results of previous calculations. Note that the effects of the cyclic operation of the system are clearly shown.  The results of the previous calculation are shown in Figure 96 which is repeted here for ease of comparison.
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Figure 104.  Plot of concentration versus time for Example 3.
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Figure 96.  Linear time, log concentration plot for Example 2. (Figure repeated from earlier.)

 Seq D2HDocument \h \r16 Examples using various sources

Introduction

	You can view the building data by loading the building file TUTOR.BLD. \definition "building file" 
	This set of examples demonstrates the various source types available in RISK.  Examples of the basic source types and their data requirements are presented.  The tutorial also provides an example of how to simulate a repeating short term source.  The building file used in the previous example will be used for the examples in this section.  


Example 4. Multiple order decay source

The examples in the previous section introduced the first order decay model.  The first example in this section is a two parameter (sometimes called two chamber) decay model.  Physically this source model could be considered a combination of a fast first order decay model and a slower first order decay model. The equation for this model is:

R(t) = R0exp(-k0 t) + R1exp(-k1 t)



(8)

 The source emission rate for this example is shown in Figure 105.
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Figure 105.  Emission rate as function of time for Example 4.

The emission model parameters for Example 4 are given in Table 10.

Table 10.  Source data for Example 4.

	R0
	k1
	R1
	k2
	Size

	1000
	.4
	5
	.00001
	10


The source will be turned on at the start of the simulation and will not be turned off.

The scenario data entry form for the example is given in Figure 106.
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Figure 106.  Scenario data entry form for Example 4.

All other data, sinks, room-to-room flows, and ventilation, for the example are the same as the data for Example 2.  

There are two occupants for this example.  Occupant One spends 24 hours a day in the living area starting at time 0.  Occupant Two spends 24 hours a day in the living area starting at time 72 hours.  The occupancy data entry screen for occupant Two is shown in Figure 107.  Note the use of the time start.
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Figure 107. Occupancy data entry for occupant Two, Example 4.

The source data entry for form for the example is shown in Figure 108.
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Figure 108.  Source data entry form for Example 4.

The concentration versus time plot for this example is given as a log x-log y plot in Figure 109.
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Figure 109.  Concentration versus time plot for Example 4.

The summary of results is shown in Figure 110.
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Figure 110.  Summary of results for Example 4.

Example 5. Effect of painting

	This is the Paint1 model in the program. \definition "empirical equation" 
	The emission rate for latex paint can be described by an empirical equation of the form

R(t) = R0/(1 +R0kt)                                            



(9)  

where R(t) is the emission rate at time t, R0 is the emission rate at time t=0 and k is a constant.  The emission rate as a function of time for paint is shown in Figure 111.
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Figure 111.  Emission rate versus time for paint used in Example 5.

All data, except the source data and occupancy data, for this example are the same as for Example 4.  The source data are entered by selecting Room from the source menu.  Click on source model column until Paint1 is displayed.  Then enter 25 for R0 and 0.003 for k.  (These are reasonable values based on limited small chamber studies.)  Enter 40 for the area of the source.  Turn the source on at time 0 and off at time 1x109 (the source is on forever). The completed data entry form is shown in Figure 112.   When all data are entered click on transfer.

Add a third occupant, the painter, to this scenario.  This occupant will enter the living room at time 0 and leave after 3 hours.  The data entry form for this occupant is shown in Figure 113.  Occupants one and two have the same activity patterns as were used in Example 4.

 Save the scenario data, then click on transfer again to return to the building form (the programs master form).  Click on calculate to calculate the concentrations.  Then calculate the exposure.  The summary display of  results is shown in Figure 114.
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Figure 112.  Data entry for latex paint emission rate parameters.
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Figure 113. Activity pattern data entry for painter.

[image: image112.wmf]
Figure 114.  Summary results for Example 5.

Example 6.  Single stage mass transfer source

Many sources can be described by a mass transfer model.  The VB model \Relate "THEORY2.DOC!33", "VB model"  of  Tichenor et al. (1991) is useful for describing the emission rate of  gas-phase-limited mass transfer sources.  Example of these sources include stains, varnishes, and waxes.  This example will assume that a 6 m2 area in the living room is being stained. The air velocity above the source for this example is 5 cm/s.  The saturation vapor pressure for stain is 15,000 mg/m3 and the diffusivity is 0.03 m2/h.  The initial emittable mass applied is 15,000 mg/m2.  The sinks, air flows, and occupancy used in Example 4 are used in this example.

The emission rate for the VB model is:

R(t) = k (Cv0M(t)/M0 - C)





(10)

where R(t) is the emission rate at time t (mg/m2-h), k is the overall gas phase mass transfer coefficient (m/h), CV0 is the saturation vapor pressure of the pollutant (mg/m3), M(t) is the concentration (mg/m2) of the emittable material in the source at time t, M0 is the initial mass concentration of emittable material in the source, and C is the in-room concentration (mg/m3)

To enter the source data select the Room Source form.  Select mass transfer as the source model.  The form is shown in Figure 115.  Select Calculate Mass transfer (Alt C M) to load the mass transfer coefficient calculator, Figure 116.  Fill in the data and click on the calculate button.  The mass transfer coefficient will be calculated and transferred to the source data form.  Enter 15,000 for C0, 15,000 for M0 and Mt1 (do not use commas).   The completed form is shown in Figure 117.

Transfer the data to the program, save the scenario, and click on calculate concentration.  The concentration time profile for 30 days in shown in Figure 118.
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Figure 115.  Source data entry screen for Example 6.

[image: image114.wmf]
Figure 116.  Mass transfer coefficient calculator with data for Example 6.

[image: image115.wmf]
Figure 117.  Completed source data form for Example 6.

[image: image116.wmf]
Figure 118.  Results for Example 6.

 Seq D2HDocument \h \r17 Examples using air cleaners

Introduction

Air cleaners can be an important tool in maintaining indoor air quality.  This section provides examples demonstrating how to use the model to analyze the impact of air cleaners on indoor air quality.  The model calculates the impact of air cleaners on pollutant concentrations and individual exposure.

The model allows analysis of the impact of in-room and central (in the HVAC) air cleaners.  The two examples in this section demonstrate how to use the model for both situations.  

Example 7. HVAC air cleaner

An air cleaner in the HVAC system cleans all the air in the building that is circulated through the HVAC.

The source for this example is located in Room 1 and is described in Table 11. Note that there are two on/off cycles for this source.  The air cleaner is 90% efficient and has a capacity of 15,000 gms.  The simulation will run 30 days.

Table 11.  Source properties for example 7.

	R0 mg/h m2
	k h-1
	Size m2
	Time on
	Time off
	Time on
	Time off

	10,000 
	0
	5
	1
	24
	32
	1000


The sink factors and air flows are the same as those in Example 1.

The air cleaner data are entered by selecting HVAC Flows Air Cleaner (Alt H A) from the main scenario menu, Figure 119.

[image: image117.wmf]
Figure 119. HVAC flows sub-menu for example 7.

The completed air cleaner form is shown in Figure 120  Transfer the air cleaner data, save the scenario, and calculate the concentrations.

[image: image118.wmf]
Figure 120.  HVAC data form for example 7.

The results are shown in Figure 121.  Note the drop in concentration when the source is turned off and the increase in concentration when the air cleaner's capacity is exceeded.
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Figure 121.  Concentration versus time plot for example 7.

Example 8. In-room air cleaner

The central air cleaner used in example 7 is replaced by an in-room air cleaner located in Room 1.  The in-room air cleaner is 80% efficient and 3 room volumes per hour are passed through it.  Room air cleaner data are entered using the scenario Room data entry form.  The completed form is shown in Figure 122.

[image: image120.wmf]
Figure 122.  In-room air cleaner data for example 8.

	
	The first page of the table of results of the calculation are shown in Figure 123.  The curve produced by pasting the data into Excel and then constructing an Excel plot is shown in Figure 124.

	The data can be copied to Excel for plotting by:

1. Select all the data in the table using the mouse or key board.  The selected data will be highlighted. \definition "^1" 
2. Select Edit Copy (Alt E C) to copy the data in the table to the Windows clipboard.

3. Load Excel (or any other Windows program.)

4.Select Edit Paste from the Excel Menu (Alt E P).

5. Plot the data using the Excel graphics functions.

The same procedure will work for other spreadsheets such as Quatro Pro.
	[image: image121.wmf]
Figure 123.  Table of results for example 8.





Figure 124.  Excel plot of results from Example 8.

The technique used to copy the results of the model calculations to Excel can be used to copy results to any other Windows program that allows data to be pasted from the Windows clipboard.

A  saved results file can be read into any program that can read ASCII files.  This includes DOS program as well as Windows programs. 

 Seq D2HDocument \h \r18 Example 9.  Long term exposure options

Introduction

The long term exposure to pollutants from a source is of increasing interest.  RISK provides three ways to estimate these exposures.

1. Run the simulation for the total time of interest.

2. Run the simulation for a limited time and assume that the long term exposure can be estimated from the average concentration calculated by the simulation.

3. Run the simulation for a limited time and assume that the remaining exposure can be estimated from the last concentration calculated by the program.

The advantage of option 1 is that estimated exposure does not contain the assumptions involved in options 2 or 3.  The disadvantage is that the computer run times can be long, especially if a wide range of options are being studied.

Option 2 is useful if cyclic behavior is being studied.  For example, assume that the situation being modeled is a 30 year exposure in an office building with a set of sources and HVAC operation that repeat every 30 days.  The first 30 days can be simulated and then the results of the simulation can be extrapolated to the entire 30 years.

Option 3 is useful for cases where there is uncertainty in the decay rate of the source after a certain time.  The simulation can be run for as long as there is confidence in the source decay rate.  Then it can be assumed that the emission rate is constant from then on, Sparks et al. (1995).  If the calculated long term exposure is small or if the risk due to the long term exposure is small, additional testing to better define the source emission decay is probably not justified.  If, on the other hand, the long term exposure is significant, additional testing is probably justified.

This example demonstrates all three approaches.

Example 9 building data

Run the program.  Fill in the Building definition form.  The completed building definition form is shown in Figure 125.
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Figure 125.  Building definition form for Example 9.

The building for Example 9 is a single compartment with a volume of 300 m3.  The height is 2.5 m.  These data are entered into the room definition form and the computer is allowed to calculate the missing dimensions.  The completed room data definition form is shown in Figure 126.
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Figure 126.  Completed room definition form for Example 9.

Transfer the room definition (Alt T or Alt F T).  Then save (Alt F S) the building and select scenarios (Alt S) to enter scenario data.

Scenario data for Example 9

	Note that compound X does not represent any real chemical.  The risk of 1 x 10-5 is a relatively high risk. \definition "compound X" 
	The pollutant of interest is compound X.  The irritant concentration of  the pollutant is 1 mg/m3 and the cancer risk is 1 x 10-5.  Constant natural ventilation of 0.5 ACH is provided.  The time of interest is 20 years.


The completed main scenario form for the example is shown in Figure 127.
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Figure 127.  Completed main scenario data form for Example 9.

The source data for the example are:


Source: a single source with area 70 m2 and emission rate given by:



R(t) = 50exp(-.9t) + 1 exp(-0.0002 t)



   Source is on from time 0 to end of simulation.

There are no sinks.

The source emission model is an R0k model with 2 terms.  The data entry form for the source (the room source form) is shown in Figure 128.
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Figure 128.  Source data entry form for Example 9.

The occupancy data for the example are:

Occupant One: 24 hours a day in the building starting at time 0.

Occupant Two: Enters building at time 0 and leaves at time 8 each day.

Occupant Three: 24 hours a day in building starting at 72 hours.

The occupant data entry forms for the three occupants are shown in Figures 129, 130, and 131.  Note that the lifetime for each occupant is 20 years.  Note that all occupancy patterns are cyclic and that the computer calculates the cycle length from the data you provide.  To tell the computer that a person does not leave the building for then entire cycle (say 24 hours), enter 0 for the time enters and 24 for the time leaves.  The data for occupant three are entered as time enter 0, time leave 24, and start time 72.  
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Figure 129.  Activity pattern for occupant One.
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Figure 130.  Activity pattern for occupant Two.
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Figure 131.  Activity pattern for occupant Three.

Run 1

For Run 1 the simulation will run for 20 years.  Other parameters are as shown in Figure 127.   Note that even on a fast computer, the run time for this simulation is quite long.

Results

The first run of Example 9 is the case where the length of the simulation is 20 years.  The risk display for this case is shown in Figure 132.
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Figure 132.  Risk display for run 1, Example 9.

Note that the cancer risk lifetime for each of the occupants is not calculated for this case.  The cancer risk is calculated for 20 years based on the full 20 years being run by the simulation.  Also note the average concentration over the twenty years is 0.0135 mg/m3.

Run 2

For Run 2, the simulation will run for 2 years and the long term exposure option # 1 (use average concentration) will be used.  The completed main scenario form is shown in Figure 133.
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Figure 133.  Main scenario form for Run 2 Example 9.

Results

The risk display for Run 2 is displayed in Figure 134.
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Figure 134.  Risk display for run 2 of Example 9.

Note that the predicted exposures for this case are somewhat higher than those calculated using the full 20 year calculation.

Run 3

For Run 3 the run time is again 2 years and the long term exposure is estimated by assuming that the final concentration calculated for the simulation is maintained for the remaining time.  The completed main scenario form for Run 3 is shown in Figure 135.
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Figure 135.  Completed main scenario form for Run 3 Example 9.

Results

The results of the Run 3 calculation are shown in Figure 136.




Figure 136.  Risk summary for Run 3 Example 9.

Note that the risk estimates for the three long term calculation options are relatively close for this example.  
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Introduction

Indoor air quality (IAQ) is determined by the interactions of sources \Relate "THEORY2.DOC!34", "sources" , sinks, and air movement \Relate "AIRFLOW.DOC!35", " air movement"  between rooms and between the building and the outdoors.  Sources may be located in rooms, in the heating, ventilation, and air-conditioning (HVAC) system, or outdoors.  There may be sinks \Relate "THEORY3.DOC!12", "sinks"  (i.e., materials that adsorb indoor pollutants) in the same locations.  Sinks may also act as sources by re-emitting the pollutants collected in them.  Individual exposure \Relate "THEORY4.DOC!27", "Individual exposure"  to pollutants from indoor sources is determined by the combination of indoor pollutant concentrations and individual activity patterns. \Relate "THEORY4.DOC!27", " individual activity patterns." 
The section on theory includes this overview chapter and chapters on sources \Relate "THEORY2.DOC!34", "sources" , sinks \Relate "THEORY3.DOC!12", "sinks" , air flows \Relate "AIRFLOW.DOC!35", "air flows" , air cleaners \Relate "THEORY6.DOC!13", "air cleaners" , exposure \Relate "THEORY4.DOC!27", "exposure" , and risk \Relate "THEORY5.DOC!36", "risk" .

General mathematical framework of the model

Mass balance equations

RISK is a multi-room model based on  an earlier models, INDOOR, Sparks (1988) and EXPOSURE, Sparks (1991).  RISK allows calculation of pollutant concentrations based on source emission rates, room-to-room air movement, air exchange with the outdoors, and indoor sink behavior.  

Each room is considered to be well mixed.  The validity of the well mixed assumption was verified in several experiments in the EPA IAQ test house, Sparks (1991), and by data reported by Maldonado (1982).

A mass balance for each room gives:

VidCi/dt = CiINQiIN - CiOUTQiOUT  + Si  - Ri


(11)

where Vi is the volume of the room, Ci is the pollutant concentration in the room, CiIN is the concentration entering the room, QiIN is the air flow into the room, CiOUT is the concentration leaving the room, QiOUT is the air flow leaving the room, Si is the source term, Ri is the removal term, and the subscript i refers to room i for a room in a set of multiple rooms, i = 1,2,.. N where N is the number of rooms.  The removal term, Ri, includes pollutant removal by air cleaners and sinks.

From the well mixed assumption  COUT equals Ci.  Equation (11)  can be rewritten as:

VidCi/dt = CiINQiIN - CiQiOUT  + Si  - Ri


(12)

Equation (12) is one of a set of similar equations that must be solved simultaneously in a multiple room model.

RISK uses a fast discrete time step algorithm developed by Yamamoto et al. (1988) to solve the series of equations.   The method is stable for all time steps and is accurate for sufficiently small time steps.  (The size of the time step depends on how rapidly concentrations are changing.  In general a time step of 1 minute is small enough when concentrations are changing rapidly, and time steps of several minutes to hours are adequate when concentrations are near steady state.)  The time step must be small enough to capture the changing behavior of the ventilation system, the sources, the sinks, and the individual activity patterns.

Source terms

The ability of any model to predict indoor air pollutant concentrations depends on the accuracy of the source models incorporated into the model.  RISK uses source models developed as a part of EPA's source characterization research program and source models provided in the literature.  The model incorporates a wide range of emission characteristics to allow simulation of the range of sources encountered in indoor spaces.  Several sources are allowed in each room.

The model includes a data base of source emission rates for these various sources based on research conducted by the Indoor Environment Management Branch, National Risk Management Research Laboratory of EPA.  The user can override the data base emission rates.

Generally sources can be divided into three categories:


Long term steady state sources such as moth cakes,


On/off sources such as heaters, and


Decaying sources such as painted surfaces.

Source behavior can be described by empirical source models or by source models based on mass transfer theory.  The constants developed for empirical models are often affected by test conditions. For example, if the mass transfer rate is limited by gas-phase mass transfer, the empirical constants are affected by the air speed over the source.  In general models based on mass transfer theory are easier to scale to new situations than are empirical models.  RISK allows the user to use both types of source models.  

 Sink terms

Research in the EPA test house; Sparks (1988) and Tichenor et al. (1991); and in the small chamber laboratory , Tichenor et al. (1991), has shown that sinks (i.e., surfaces that remove pollutants from indoor air) play a major role in determining indoor pollutant concentrations.  These sinks may be reversible or irreversible.  A reversible sink re-emits the material collected in it, and an irreversible sink does not.  Sink behavior depends on the pollutant, on the nature of the sink, and on environmental factors such as temperature, air velocity, and humidity.  A sink may appear to be irreversible when the pollutant concentration is high and then become reversible when the pollutant concentration is low.  Considerable research is necessary to define the behavior of sinks.   Sink models have been published by Tichenor et al. (1991) and Axley (1991).

The sink model used in RISK is based on research of Tichenor et al.(1991):

Rs = kaCAsink - kdMs nAsink




(13)

where Rs is the rate to the sink (mass per unit time), ka is the sink rate constant (length per time), C is the in-room pollutant concentration (mass per length cubed), Asink is the area of the sink (length squared), kd is the re-emission or desorption rate constant (1/time if n =1),  Ms is the mass collected in the sink per unit area (mass per length squared), and n is an empirical constant. The recommended value of n, based on EPA research, is 1, Sparks (1991).

Experimental data in the EPA test house and small chambers show that, for typical gaseous organic pollutants of interest in indoor air, ka ranges from about 0.1 to 0.5 m/h, and the sink re-emission rate, kd, is about 0.008/h for carpet and 0.1/h for most other materials.  

The impact of sinks on individual exposure depends on the activity patterns.  Sinks slightly reduce the peak exposure of individuals spending 24 h/day in a building and have no impact on their cumulative exposure.  Sinks can have major impacts on the exposure of individuals with other activity patterns.   

Exposure

The types of exposure of interest are the instantaneous exposure and the cumulative exposure.  The instantaneous exposure is the exposure at any time, t, and the cumulative exposure is the total or integrated exposure over the time of interest.  The nature of the pollutant and the effects of the pollutant determine which type of exposure is more important.

Individual exposure is determined by the time spent at a given pollutant concentration.  Therefore, it is a function of both the building concentration time history and the individual activity pattern--that is, where the individual is located at what time. Different activity patterns, for example, entering and leaving a building at different times or moving from one room to another, result in different exposures to the same building pollutant concentration time history.  Sparks (1992) discusses exposure modeling.

  Calculation of exposure requires the pollutant concentration, the time exposed to the concentration, and (for inhalation exposure) the breathing rate and the volume per breath.  The time exposed to the concentration depends on the individual activity pattern.

An activity pattern, in the context of the model, is defined by providing the time a person enters and leaves the various rooms of the building, or leaves the building for the outdoors.  The model allows up to 10 room changes per day.  The model is based on a 24-hour day. The activity patterns in the model repeat from day to day.

The model provides instantaneous exposure time plots and cumulative exposure time plots for individual activity patterns.  The instantaneous exposure allows identification of high exposure situations and of the peak exposure.

While the model was designed to allow assessment of the impact of indoor air pollution sources and sinks and IAQ control options on individual exposure from specific activities, it can also be used to help estimate population exposures if data on population activity patterns are available.  The model can be run for each activity pattern and then the results can be weighted according to the population statistics.

Model verification

The model predictions of concentration versus time have been compared to experimental data from the EPA IAQ test house.  In all cases the agreement between predictions and experiment has been good.  Predicted versus measured concentrations for many of these experiments are plotted in Figure 137.  Details of the comparisons between model predictions and indoor pollutant concentration are given by Sparks et al.(1991).
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Figure  137. Predicted versus measured concentration for test house experiments.    Predicted = 1.6 + 0.99 x measured, r2=0.96.
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Introduction

RISK incorporates a wide range of source types and source models.  Most source behavior can be simulated using the features found in RISK.  The generic source models provided by RISK are:

· Empirical models based on exponential decay.

· Empirical models for drying of latex paint.

· Mass-transfer based models that allow two phases of mass transfer.

· Empirical models based on polynomial curve fit to experimental data.

Each of these models is described in detail below.  Where possible, suggested values of source parameters are provided either in the source data base accompanying RISK or as part of the on-line help provided with RISK.

Source Models

Empirical decay models

First order decay

The most common source emission models are obtained by fitting dynamic chamber data.  The technique is described by Dunn and Tichenor (1988).  The most common of the empirical models is the first order decay model:


R(t) = R0e-kt




(14)

where R(t) is the emission rate as a function of time (mg/h/m2), t is time h, R0 is the initial emission rate mg/h/m2, and k is the first order decay constant h-h.  The total mass emitted (ME) is given by:










(15)

The emission half life (the time required for the emission rate to decay to R0/2), t½, is given by:









(16)

An example of the chamber data used to develop a first order decay model is given in Figure 138.

A wide range of sources can be described by the model in Equation (14).  In general sources with decay constants larger than 0.2/h are limited by gas phase mass transfer and those with decay constants smaller than 0.01/h are limited by source phase mass transfer.
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Figure 138.  Example of chamber data used to estimate R0 and k.

Estimating R0 and k.

R0 and k are estimated by applying non-linear curve fit techniques to chamber data.  The solution to the differential equation governing the change in concentration in a well-mixed dynamic chamber without sinks is



    


(17)

where c(t) is the concentration at time t, A is the area of the source, N is the air exchange rate, and V is the chamber volume.

R0 and k can be obtained from chamber data by using non-linear curve fitting techniques to fit this equation to the chamber data.  A program to perform this fit is provided by the RISK model.  This program is accessed through the Room Source menu. The program is based on a program written by Guo (1989).  

Estimates of source terms for several sources are given in Table 12.  These data are based on experiments conducted in EPA's small chambers and in EPA's IAQ test house.

Table 12. Emission rates of  total VOC for selected indoor pollutant sources.

	Source
	R0 mg/m2-h
	k 1/h

	Wood stain
	17,000
	0.4

	Polyurethane

	20,000
	0.25

	Wood floor wax
	 20,000

	6.0

	Moth crystals

	14,000

	0

	Dry cleaned clothing
	    1.6

	0.03

	Liquid nails
	10,000
	1


Multi-compartment decay models

In some cases emission rates can be described as a sum of several exponential decay rates

R(t) = R1e-at + R2e-bt + R3e-ct


(18)

where R1, R2, R3, a, b, and c are empirical constants.  Some authors refer to models of the type shown in Equation (18) as multi-compartment models.  Each compartment is described by a first order decay model.  Each compartment has a half life.  For example, the half life of compartment 1 is ln(2)/a.  An example of the type of chamber data that can lead to a multi-compartment decay model is given in Figure 139 from Mølhave et al. (1995).
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Figure 139.  Multi-compartment emission model from Mølhave et al. (1995) 
Techniques for fitting chamber data to multi-compartment models are discussed by Mølhave et al. (1995).
This figure also demonstrates the problems encountered in developing models for sources with long-term emissions.  Mølhave et al. (1995) believe that the three-phase model is the best model for this source.  However, without additional data, it is difficult to choose between the two-phase model and the three-phase model.  The three-phase model was selected because it was believed to provide a better estimate of the very long-term (up to 70 years) emissions. See Sparks et al. (1995) for additional discussion of the problems of developing emission models for sources with long-term emissions.

Latex paint models

VOC emissions from latex paint do not behave in a simple decay manner.  Hansen (1974) recommend the empirical model:

 







(19)

where R0 is the emission rate at time t = 0 and a is an empirical constant, for latex paints.  An example value of R0 for total volatile organic compounds (TVOC) is 80 mg/m2-h and an example value of a is 0.003 m2/mg.

Other empirical models

The model provides a up to a forth order polynomial to fit emission rate data from sources not covered by the models discussed above.     This model is of the form:

R(t) = a + bt + ct2 + dt3 + et4 



(20)

where a, b, c, d and e are empirical constants.  This form of the emission rate model might be useful for cases where the emission rate is calculated directly from the differential equation describing the change in chamber concentration as a function of time.  In this case a table of emission rate at various times could be generated.  The polynomial curve fit might provide a satisfactory description of the data.

Comments on empirical models

The constants developed for empirical models are often affected by test conditions. If the total emittable mass is increased, for example by heavy application of a wood stain, R0 and/or k in the first-order decay model must change.  If the mass transfer rate is limited by gas-phase mass transfer, the empirical constants are affected by the air speed over the source.  Source testing should be conducted to provide scaling factors or under conditions similar to those encountered in indoor environments

Mass-transfer based models

General

Scaling the empirical models developed from chamber data to real buildings is a major problem with empirical models.  This is especially true when the emissions are limited by gas-phase mass transfer processes.  In this case, the emission rates are highly dependent on the gas velocity in the chamber.  

The general mass transfer process for indoor sources is for pollutants to transfer from the interior of the source to the source/air interface, and from the source/air interface to the room bulk air. This physical model is shown in Figure 140. Each of these mass transfer processes can be described by a driving force divided by a resistance.  At steady state the rates of the two mass transfer processes are equal.
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Figure 140.  Physical model of source.

The following discussion is for a source with unit area.  The driving force for mass transfer from within the source to the source/air interface is the difference in pollutant concentration at the interface, mi, and at the interior of the source, ms.  The resistance to mass transfer is 1/ks, where ks is the source mass transfer coefficient.  The mass transfer rate, R, is 

R = (ms - mi)ks





 (21)

Typical units of R are milligrams per square meter hour,  units of m are milligrams per square meter, and units of ks are hours-1 for indoor sources. 

The driving force for mass transfer from the interface to the room is the difference between the gas-phase concentration at the interface, Ci, and the room concentration, Cr.  The resistance to mass transfer is 1/kg, where kg is the  gas-phase mass transfer coefficient.  The rate of mass transfer, R, is:

R = (Ci-Cr)kg





(22)

Typical units of Ci and Cr are milligrams per cubic meter and units of kg are meters per hour.

Equations (21) and (22) require knowledge of the pollutant concentrations at the source/air interface which are difficult to obtain.  However, bulk-phase pollutant concentrations can be obtained.  The bulk-phase concentrations can be used if the equations are rewritten to use overall mass transfer coefficients and equilibrium concentrations, Foust et al. (1960).  

The pollutant concentration in the room in equilibrium with the pollutant concentration in the source is:

C*  = f(ms)





(23)

where f(ms) is some function.  For simplicity assume that the function is linear.  Then

C*  = ams





(24)

where a is a constant.  In the VB model of Tichenor et al. (1993):

 a = Cv0/M0 





(25)

where Cv0 is the initial vapor concentration and M0 is the initial pollutant concentration in the source.

At the interface Ci is in equilibrium with mi, Ci = f(mi) or for the linear model:

 Ci = ami





(26)

Equations (21) and (22) can be rewritten using the equilibrium relationship to give:

(a/ks)R = (ams - ami) =  (C* - Ci)




(27)

and

(1/kg)R = -(Cr - Ci)





(28)

Equations (27) and (28) can be added to give:








(29)

for overall mass transfer expressed in terms of gas-phase concentrations.  Equation (29) can be rewritten in terms of an overall gas-phase mass transfer coefficient, Kg as:









(30)

Note that no assumptions are made about the relative magnitudes of the two resistances to mass transfer. The use of Kg means that mass transfer is described in terms of gas-phase concentration data.

The overall mass transfer rate equation in terms of source phase concentrations is:
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(31)

where m* is the equilibrium concentration expressed in source phase units (m* = C*/a).

Equation (31) can be rewritten in terms of an overall source-phase mass transfer coefficient, Ks , as:








(32)

 Again note that no assumptions are made about the relative magnitudes of the two resistances to mass transfer.  The use of Ks means that the mass transfer is described in terms of source-phase concentrations.

Either Equation (30) or Equation (32) can be used depending on the data available. Because gas-phase data are generally more readily available than are source phase data, Equation (30) is the more useful in indoor situations.

The problem of developing a mass-transfer-based emission model becomes one of determining both the appropriate mass transfer coefficient and the equilibrium relationship.  

Mass transfer model for gas-phase-limited mass transfer

In most situations, one of the mass transfer resistances is much greater than the other, and the smaller of the two resistances can be neglected.  For many important indoor pollutant sources (e. g. wet sources),  the gas-phase resistance dominates (i. e., 1/kg  >> a/ks), and a/ks  can be neglected. Equation (29) becomes:








(33)

Boundary layer theory, Bennett and Myers (1962), and dimensional analysis, Foust et al. (1960), show that gas-phase-limited mass transfer is best analyzed in terms of three dimensionless groups: the Nusselt number, Nu; the Reynolds number, Re; and the Schmidt number, Sc.  The Nusselt number is: 








(34)

where L is some characteristic length of the source and D is the diffusivity of the pollutant. The Reynolds number is:








(35)

where v is the gas velocity over the source, SYMBOL 114 \f "Symbol" is the gas density, and SYMBOL 109 \f "Symbol" is the gas viscosity.  The Schmidt number is:








(36)

Correlations  based on the three dimensionless groups have been developed for many geometries and flow patterns.  For turbulent mass transfer, Nu/Sc0.333 = f(Re).  The functional form of f(Re) depends on the flow geometry.  Axley(1991), Heinsohn (1991), and others suggest that, for indoor air situations, unidirectional flow over flat plates is the correct flow geometry.   In this case boundary layer theory, Bennett and Myers (1962),  predicts that:





 (37)

Gunnarsen (1991) suggested that the correct geometry is flow past a sphere.  In this case, Bird et al. (1960) give:









(38)

 The diffusivity and Schmidt numbers for a range of organic vapors are give in Table 13.  Note that, except for formaldehyde, there is little variation in the diffusivity and that variations in Sc0.33 span a narrow range (1.2 - 1.5).  Within the accuracy of the data, the effects of the Schmidt number can be ignored and data from indoor sources can be correlated as:

Nu =  f(Re)





(39)

for the organic vapors found indoors.  Once the relationship between Nu and Re for a given geometry is determined, the relationship can be applied to all sources of the same geometry where emissions are limited by gas-phase mass transfer.  The relationship between Nu and Re can determined experimentally.

Sparks et al. (1994) determined that the relationship between Nu and Re for gas-phase​-limited mass transfer is given by

Nu = 0.33Re0.67





(40)

Table 13. Diffusivities and Schmidt numbers for VOC indoor pollutants

	Pollutant
	Diffusivity (m2/h)
	Schmidt No.

Sc
	Sc0.33

	P-dichlorobenzene 
	0.026
	2.12
	1.28

	Formaldehyde
	0.06
	0.92
	0.97

	Decane
	0.021
	2.63
	1.38

	Benzene
	0.028
	1.98
	1.25

	Perchloroethylene 
	0.03
	1.84
	1.22

	Ether
	0.032
	1.72
	1.20

	M-chlorotoluene
	0.023
	2.35
	1.33

	Isopropyl iodide
	0.032
	1.74
	1.20

	Octane
	0.024
	2.31
	1.32

	Dodecene
	0.018
	3.06
	1.45

	Toluene
	0.029
	1.91
	1.24

	N-butyl acetate
	0.021
	2.63
	1.38


The correlation is based on small chamber and test house experiments.  The data used to develop the correlation and the regression line are shown in Figure 141.
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Figure 141. Nu vs. Re correlation from Sparks et al. (1995).

Equilibrium relationship for sources

A mass-transfer-based model requires knowledge of the mass transfer coefficient and of the equilibrium relation between gas-phase pollutant concentration and source-phase pollutant concentration.  The assumed equilibrium relationship is, Tichenor et al. (1993):


C* = Cv0M(t)/M0




(41)

where M(t) is the emittable mass concentration in the source at time t and M0 is the initial emittable mass concentration (typical units of M are milligrams per square meter).  Two small chamber experiments were conducted to determine the validity of this assumption.

For the first experiment about 4 g of wood stain was applied to a 0.1 m2 red oak veneer board and for the second experiment 11.5 g of wood stain was applied to a 0.16 m2 red oak veneer board.  For each experiment the sample was immediately placed in a 53 L chamber.  The chamber was operated alternatively under static mode (no air flow) and dynamic mode (1 air exchange per hour).  Each static period lasted for 2 hours to allow the system to come to equilibrium.  Each dynamic period lasted 1 hour.   The VOC concentration in the chamber was monitored continuously by a gas chromatography/flame ionization detector (GC/FID) equipped with a 5-mL automatic sampling loop.  

The total emittable mass concentration was calculated by integrating the concentration time curve from t = 0 to t = he equilibrium relationship was calculated for each static period.  The M(t) was calculated as:


M(t) = [M0 - (W1 - W2)]/S




(42)

where W1 = total VOC mass leaving the chamber at time t, W2 = total VOC mass remaining in the chamber at time t, and S = sample area.

The results of these experiments for two tests are shown in Figure 141.  A least squares linear regression to the data gives:



C* =  17.6 M(t)/M0




(43)

when the intercept is forced through zero, with a regression r2 of 0.9.  Cv0  calculated from the least square fit is 17.6 g/m3. Cv0 from earlier experiments was 17.4 g/m3.  The VB model using the CV0  determined in earlier experiments is: 



       C* = 17.4 M(t)/M0
 



(44)

The agreement between experiment and model is acceptable for use in the emission model, Figure 142.
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Figure 142.  Equilibrium concentration data for wood stain, Sparks et al. (1995).

Estimating mass transfer coefficients

The mass transfer coefficient for gas-phase limited mass transfer can be estimated using equations 34, 35, and 40.  The computer model will calculate the mass transfer coefficient from these equations.

Source-phase limited mass transfer

The emissions rate from many sources is limited by mass transfer in the source.  These sources are often classified as diffusion limited sources.  In principal, source phase mass transfer coefficients can be calculated if the diffusion coefficient of the pollutant within the source is known.  Unfortunately, the data on pollutant diffusivity in sources is limited.  Source-phase mass transfer coefficients have to be developed by experiment.

Matthews et al. (1987) and others have published mass transfer coefficients for formaldehyde in particle board.  Sparks et al. (1995) used their data to develop a mass transfer model for formaldehyde in pressed wood product given in Equation (45):


R(t) = kf (C - C0M/M0)




(45)

where kf is the formaldehyde mass transfer coefficient, 0.25 m/h, C is the room concentration of formaldehyde (mg/m3), C0 is the equilibrium formaldehyde concentration, 0.3 mg/m3, M is the mass of formaldehyde in the particle board, mg/m2, and M0 is the total emittable mass of formaldehyde in the particle board, mg/m2.  The value of M0 is difficult to obtain experimentally.  A review of much of the data in the literature suggests that a value of 500 mg/m2 will give acceptable results.

Mass transfer coefficients for other pollutants in other sources are generally not available.  Reported work on VOCs in carpet suggests mass transfer coefficients of about 1x10-12m/h.  

Diffusion limited sources

A different mass transfer based model can be developed based on the assumption that mass transfer is limited by diffusion from the inside the source to the surface.  The diffusion equation can be solved to yield a model of the form:








(46)

where MD0 is the initial emittable mass concentration (mg/m2 )  in the diffusion limited source, D is the diffusivity in the source, 

is the depth of diffusion, and t is time.  Equation (46) can be rewritten as:









(47)

where 

.  

The diffusion limited source model has been used to describe the emissions of various pollutants from carpets and other types of flooring, see for example Christiansson et al.  (1993).

Latex paint model

Research in the EPA source characterization laboratory shows that this model for diffusion limited source can be combined with the VB model to describe the emissions of VOCs from latex paint.  The latex paint model (called Paint2 in the computer model) is:






(48)

where k is the gas phase mass transfer coefficient, Cv0 is the initial vapor pressure, Mv(t) is the gas phase limited emittable mass left in the source at time t, Mv0 is the gas phase limited emittable mass at time 0, and C is the in room concentration.  Values of the parameters for the model are given in Table 14.

Table 14.  Parameters for latex paint model.

	Pollutant 
	Cv0 mg/m3
	Mv0 mg/m2
	hr.5

	Propylene glycol
	1.5
	30.4
	2.53x10-3

	Ethylene glycol
	9.47
	84.0
	2.33x10-3

	Butoxyethoxyethanol
	6.25
	75.6
	7.77x10-4

	Texanol
	24.7
	487
	4.90x10-4

	TVOC
	43.3
	657
	1.71x10-3


The values of the parameters given in Table 14 are preliminary values based on limited experimental data.  The initial emittable mass due to diffusion, MD0, is given by:

MD0 = MA - Mv0




(49)

where MA is the total emittable mass applied (mg/m2). 

Shower model (New material 11/14/99)

One source of indoor exposure to volatile organic compounds (VOC) is from contaminated tap water during use.  Showering is one potential water use that can contribute to significant exposure.  A new source model has been added to RISK to allow analysis of potential exposures to VOCs due to showering.

The shower model is based on a shower model developed by Little
.  The model is a mass transfer model using the overall mass transfer coefficient concept.  As a drop falls trhough a shower, VOCs are volatilized and emitted to the air. The change in VOC concentration in the drop is given by:
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Equation 1
where cw is the VOC concentration in the drops, KL is the overall mass transfer coefficient based on the liquid phase, A is the area for mass transfer, VL is the volume of liquid, ca is the VOC concentration in the air, and m is the Henry's law constant.

If we assume that the during the short time that the drops take to fall from the shower head to the drain the air concentration is constant, the solution to Equation (1) is
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Equation 2
where cw,out is the VOC concentration in the drop leaving the shower, cw,in is the VOC concentration in the water entering the shown, and N is a dimensionless mass transfer coefficient given by (KLA/QL) where QL is the liquid flow rate.

The amount of material emitted into the air by the liquid falling from the shower head to the drain is QL(cw,in – cw,out).

The input for the shower source are:

VOC-- concentration in the water, mg/m3 (note µg/L = mg/m3 )

KL A-- the overall mass transfer coefficient time the area for mass transfer found from Table I.

m-- the Henry's law constant also found in Table I.

Note that KL A in Table I are from Little and are based on fits to experimental data. The value of m given in Table I is for 20oC. The Henry's law constant can be corrected for temperature using:
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Equation 3
where T is in K and J is given in Table I.

Table 15. Values for shower model.
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Introduction

Sinks are indoor materials that remove pollutants from the indoor air.  In many cases the pollutants are re-emitted later.  This is especially true for VOCs.  Most indoor materials act as sinks.  The discussion that follows is limited to sinks for VOCs.

Theory

The study of adsorption/desorption of gases from various solid surfaces has resulted in several isotherm equations, Daniels and Alberty  (1961).  The Langmuir isotherm is the simplest isotherm.  At equilibrium the Langmuir isotherm is:









(50)

where 

 is the adsorption rate constant; Ce is the equilibrium concentration of the adsorbate in the gas phase,

is the desorption rate constant; and 

is the fraction of the surface covered.    For low concentrations,  

<<1 and  Equation (50) can be rewritten as, Tichenor et al. (1991)









(51)

Because the equilibrium mass per unit area in the sink, Ms, is proportional to 

, Equation (51) can be written:








(52)

where kd is the desorption constant.  The mass balance for a sink of area A is







(53)

The Langmuir isotherm, Equation (50), can be combined with the differential equations for the chamber mass balance, Dunn and Tichenor (1988), to provide a method for estimating sink constants from chamber data, Tichenor et al. (1991).

Tichenor et al. report that the Langmuir isotherm works well for ceiling tile and wallboard but that the desorption process for carpet deviates from the Langmuir assumptions.  

Tichenor et al. reported IAQ test house experiments demonstrating the effects of indoor sinks on indoor pollutant concentrations.  They reported that the Langmuir sink model predicted the sorption of VOCs by indoor materials reasonably well.  However, the Langmuir model under estimated the re-emissions phase.   Sparks et al. (1991)  recommend that the sink constants shown in Table 15 be used.  These recommendations are based on a combination of  IAQ test house and chamber research.

Table 15.  Recommended sink constants.

	Material
	Pollutant
	ka m/h
	kd 1/h

	Carpet
	TVOC
	0.1
	0.008

	Painted wallboard
	TVOC
	0.1
	0.1

	Ceiling tiles
	TVOC
	0.1
	0.1

	All surfaces
	P-dichlorobenzene 
	0.35
	0.01


Effects of sinks

An irreversible sink (i.e., a sink that does not re-emit pollutants) acts as an air cleaner and reduces exposure for as long as the sink is active.  The effects of reversible sinks (i.e. sinks that re-emit pollutants) are more complicated because they can have a major impact on the concentration time history of the pollutants.

Reversible sinks generally slightly reduce the peak exposure and greatly extend the time of exposure.  The exact effect of a sink is scenario dependent and must be determined by model analysis.
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Introduction

Air flows; between the indoors and the outdoors, between rooms, and between floors; play a major role in determining IAQ.  The air flows between the indoors and the outdoors provide a mechanism for exhausting pollutants from the indoors to the outdoors and a mechanism for diluting pollutant concentrations with clean outdoor air.  These same air flows can provide a mechanism for introducing pollution into the indoors when the outdoor air is polluted.

Air flows between rooms provide a mechanism for moving pollutants from one space to another.  These air flows are driven by natural temperature differences in the space, by the HVAC system, or by other fans.

The purpose of this chapter is to provide guidance on selecting values for air flows for use in the model.  Most of the information in this section is based on research conducted in the EPA IAQ test house.  The air flows in the test house have been studied using tracer gases, flow visualization, and physical measurements of the air flows.  The IAQ test house is expected to be representative of typical residences and thus the suggestions based on data obtained in the test house should be reasonable for most residences.  Applying the guidance to commercial buildings is somewhat less certain.

Equations for estimating indoor-outdoor air flows are presented.  These equations are provided to allow the user to estimate reasonable values for flows as a starting point for analysis.  The equations are not included in the RISK model.

Air exchange between indoors and outdoors

Naturally driven 

Naturally driven air exchange between the indoors and the outdoors is driven by temperature differences between the indoors and the outdoors and by wind.  The air enters and leaves the indoors through cracks in the building shell.  The general equation describing air exchange is


Q = kA(p)c





(54)

where Q is the flow rate (volume/time), k is an empirical constant, A is the area of the crack, p is the pressure difference between indoors and outdoors, and c is a constant.  Hayakawa and Togari (1990) suggest that the equations in Table 16 be used to estimate infiltration in office buildings.  The units to be used with Table 16 are: A is the area of the building envelope in m2 and p is the absolute value of the indoor/outdoor pressure difference in kg/m2  (1 kg/m2 = 9.8 Pa).

Table 16.  Suggested equations for estimating infiltration in buildings, Hayakawa and Togari (1990).

	Class of construction
	Equation for infiltration m3/h

	Tight
	0.72A(p)1/1.5


	Average
	1.44A(p)1/1.5


	Loose
	2.88A(p)1/1.5



Table 17 shows the tentative classification scheme suggested by Hayakawa and Togari.

Table 17.  Suggested classification of buildings for airtightness as a function of construction, Hayakawa and Togari (1990).

	Construction
	Class

	Cast inplace reinforced concrete
	Tight to average

	Steel or steel reinforced concrete

Metallic curtain wall
	Average to loose

	Other
	Loose


The air exchange between the outdoors and indoors is usually expressed as the ratio of the air exchange flow rate divided by the building volume and is called air changes per hour (ACH).  The pressure difference, p, is generated by temperature differences and by wind.  In many situations the pressure difference generated by temperature differences dominates.  For the EPA IAQ test house the following equation describes the naturally driven air exchange:

ACH = a + b(t) + c S




(55)

where ACH is the overall air exchange rate between the indoors and the outdoors (h-1), t is the difference between the indoor and outdoor temperatures (ºC), and S is the wind speed (m/s).  This correlation is based on tracer gas and meteorology data taken over a several month period.  


a = 0.184


b = 0.0129


c = 0.0882

This correlation is valid for an air exchange rate range of 0.15 to 0.6 h-1.

In general reasonable values of air exchange between the indoors and outdoors are:

0.3 for tight construction,

0.5 for typical energy efficient construction, and

1.0 for  construction over 30 years old.

Experiments in the test house show that achieving air exchange rates much above 1.0 air changes per hour is difficult even with windows open.  The measurements also indicate that short circuiting and non-uniform mixing are likely when steps are taken to obtain high air exchange rates.

Under normal wind conditions, the assumption that air exchange between the indoors and the outdoors is uniformly distributed throughout the test house is reasonable.    Closing internal doors in the test house has a significant impact on the air exchange rate between the indoors and the outdoors and the distribution of outdoor air, especially when the heating and air conditioning  (HAC) system is on. Closed internal doors can double the air exchange rate between the indoors and the outdoors when the HAC is operated.  The room where the door is closed becomes positively pressureized because of the air being circulated by the HAC.  The outdoor air leaves through the room where the doors are closed and enters through the rest of the house.

Test house experiments also show that turning on a typical (flow < 30m3/h) bathroom exhaust fan does not change the overall air exchange rate for the house.  The exhaust fan does affect the location where indoor air is exhausted to the outdoors.

HVAC driven 

A builidng with an HVAC system has two paths for air exchange with the outdoors--natural ventilation and mechanical ventilation.  Mechanical ventilation is determined by the operation of the HVAC system, including the mechanical exhaust.  Values for mechanical ventilation can be determined from the design of the system.  When system design is used to determine the amount of HVAC driven air exchange with the outdoors, special attention should be paid to the value of the HVAC driven exhaust.

If design values for the HVAC driven ventilation are not available, calculations can be based on the values suggested by ASHRAE Standard 62-89 (ASHRAE 1989).

 A review of limited field data indicates an air exchange rate of 0.5 h-1 is a reasonable value if data are not available.

Room-to-room air flow

Naturally driven

Test house experiments show that the room-to-room air under normal conditions is at least 3 room volume air changes per hour.

HVAC driven

The nature of the HVAC driven room-to-room air flows depends on the design of the HVAC system.  In a system where return vents are provided in each room, the room-to-room air flows driven by the HVAC system (or the HAC) are normally small.  In a system where there is a central return, the HVAC driven room-to-room flows are the HVAC flows.

Interactions between HVAC and natural flows

Experiments in the EPA IAQ test house show that even with the HAC system on, there are still naturally driven room-to-room air flows, Sparks (1991).  These air flows provide additional mixing between rooms and should be considered when evaluating the effectiveness of local ventilation and exhaust or in-room air cleaners  for IAQ control.

Floor-to-floor air flows

Floor-to-floor air flows can be looked at as a special case of room-to-room air flows.  There are few data on floor-to-floor flows.  

Naturally driven

Naturally driven floor-to-floor flows are driven by the stack effect.  The outdoor air enters the building on floors below the neutral plane and exits from floors above the neutral plane. Data from a small (91 m3) test house were reported by Fortman et al. (1990) and are shown in Figure 143 .  These data can be scaled to other house volumes.
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Figure 143.  Floor-to-floor air flows for test house with HAC system off

Hayakawa and Togari (1990) describe a procedure that can be used to estimate floor-to-floor air movement in multistory buildings.  Note that the values calculated using this technique should be considered as reasonable starting values. Actual values should be measured and used, if possible.

HVAC Driven

If an air handler serves several flows, significant floor-to-floor air flow occurs in the HVAC system and can be accounted for by the HVAC flows.  When different flows are served by different air handlers, the problem of floor-to-floor air flows is more difficult.  Fortman et al. (1990) reported that the floor-to-floor air flows in their test house were several hundred cubic meters per hour when the HAC was on.
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Introduction

Air cleaners can be used to remove pollutants from dirty outdoor air before it enters the building  or they can be used to remove pollutants from indoor air.   The ASHRAE ventilation standard 62-89 (ASHRAE 1989) requires that outdoor air that does not meet the EPA ambient air quality standards be cleaned before it can be used for ventilation air in a building.  ASHRAE 62-89 does not require that air cleaners be used to clean indoor air.  However, the standard does suggest that cleaned, recirculated indoor air can be used to reduce the outdoor air requirements of the standard.  

The type of air cleaner required for controlling IAQ depends on the pollutant(s) that must be removed.  Air cleaners are available for removing particulate matter from the indoor air and for removing gaseous pollutants.  The performance of particulate air cleaners is better understood that is the performance of gaseous air cleaners.  

Air cleaners may be located in the central HVAC system or in a single room.  The impact of the air cleaner on IAQ depends on where the air cleaner is located, where the sources are located, and where the occupants of the building are located. 

The following discussion provides a brief summary of the performance of particulate and gaseous air cleaners.  The performance information can be used with the air cleaner options in RISK to assess the impact of various air cleaning strategies on IAQ. 

Particulate air cleaners

There are two main classes of particulate air cleaners:


electrostatic precipitators (often called electronic air cleaners) and;


filters (some of which claim to be electrostatically augmented).

The two types of air cleaners collect particles by different physical mechanisms.  Electrostatic precipitators place an electric charge on the particles and then collect the particles in an electric field.  Filters collect particles using diffusion, interception and impaction.

Filters

Filters collect particles by three mechanisms:


Diffusion 


Interception


Impaction

Each mechanism is strongest for a particular range of particle sizes.  

Diffusion is strongest for very small particles.  This mechanism depends on the random motion of small particles.  As particles become smaller, they behave more like gases and have high diffusion coefficients--that is they have large random displacements.   Diffusion is the dominant filtration mechanism for particles with diameters less than 0.1 µm.

Interception is strongest for particles with diameters nearly the same as the diameters of the fibers in the filter.

Impaction is strongest for large particles. 

The fact that three mechanisms are active in filters, each covering a specific particle size range, gives filters a characteristic particle collection efficiency versus particle diameter curve.  A typical curve is shown in Figure 144.
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Figure 144.  Typical efficiency curve for a filter.

The pressure drop across a filter must be considered in designing an air cleaner system based on filters.  Also the fact that the pressure drop increases as the filter becomes dirty must be considered.

Electrostatic precipitators

Electrostatic precipitators collect particles by first placing an electric charge on the particles and then collecting the charged particles.  Air cleaner electrostatic precipitators  have separate stages for charging and collecting the particles.  Electrostatic precipitators may generate ozone.  However, the increase in indoor ozone concentration due to ozone generated by well designed, installed, operated, and maintained ESP is small.

The experimental data (Hanley et al. 1994) show that the collection efficiency of electrostatic precipitator air cleaners is essentially flat for most of the particle diameter range.  A typical result from Hanley et al. is given in Figure 145.
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Figure 145.  Typical efficiency curve for electrostatic precipitator.

Electrostatic precipitators generally do not increase the system pressure drop.

Air cleaners for gases

General

There are numerous gaseous pollutants in the indoor environment.  These pollutants include inorganic gases such as carbon monoxide, CO, sulfur dioxide, SO2, ozone, O3, and oxides of nitrogen, NOx, as well as organic vapors.   

The performance of gaseous air cleaners has not been as well studied as that of particulate air cleaners.  The performance of  gaseous air cleaners depends on the chemical composition of the gases being collected and the type of the air cleaner.  Most indoor air cleaners are claimed to remove VOCs from the air.  

Activated carbon

Air cleaners based on activated carbon are the most common gaseous air cleaners.  The activated carbon can be used in granular form in thin beds or in fibers (either fibers of carbon or of carbon impregnated material).  The typical residence time in a carbon filter is less than a second.  

Activated carbons are characterized by high initial efficiency followed by a decrease in efficiency.  A common way of characterizing activated carbon  is by the time to achieve 10% breakthrough, i.e. the time required for the efficiency to drop to 90%.  The breakthrough time is a function of the concentration.  Research is ongoing to define the relation between concentration and breakthrough time.  A typical breakthrough curve, based on EPA sponsored research, is shown in Figure 146, VanOsdell and Sparks (1995).  The bed capacity estimated from Figure 146 is shown in Figure 147.




Figure 146.  Breakthrough times for toluene in carbon. t 10% is time for 10% breakthrough and  t 50% is time for 50% breakthrough.




Figure 147.  Carbon bed capacity for toluene 50% RH.

A typical HVAC system carbon bed has a mass of about 32 kg.  Thus the bed capacities are on the order of a few kg or less for typical indoor VOC concentrations.
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Introduction

There are two type of exposure of general interest--population exposure and individual exposure.  Individual exposure is the exposure of most interest in meeting the mission of the IAQ engineering research program.

Individual exposure is determined by the time spent at a given pollutant concentration.  Therefore, it is a function of both the building concentration time history and the individual activity pattern--that is, where the individual is located at what time. Different activity patterns, for example, entering and leaving a building at different times or moving from one room to another, result in different exposures to the same building pollutant concentration time history. Exposure can be controlled by taking both factors into account.   Sparks (1992) discusses exposure modeling.  

Exposure analysis requires first prediction of the building concentration time history.  Then individual activity patterns are imposed on the building time history to develop individual exposure.  Two classes of exposure are of interest--instantaneous exposure, Ei (t),


Ei (t) = C(t)




(56)
where C(t) is the concentration at time, t, and cumulative exposure, Ec between times t1 and t2 










(57)
The peak exposure is the maximum of the instantaneous exposure versus time curve.

 Which of these two classes of exposure is appropriate for a given situation depends on the nature of both the pollutant and the effect.  The effects of interest may be classified as: chronic, acute, and irritation/odor.  The intensity and prevalence of these types of effects both depend to some extent on the maximum concentration to which each is occupant is exposed, the exposure duration, and its average concentration.  Some effects may additionally have a delay between exposure and occurrence of effects.  For these the entire time profile of exposure is needed.  In general chronic effects are due to cumulative total exposure while irritation and odor responses occur at concentrations above some threshold level.  Irritant effects are an example of threshold effects.  If the concentration is below some value, the exposure is of little concern.  If the concentration exceeds the irritant level, the exposure becomes important.

In other situations the concentration and time exposed are both important.  In this case the instantaneous exposure over the time of interest is important.  Most of the ambient air quality standards include both a time component and a concentration component.
Population exposure is determined by determining the fraction of the total population that has a given individual exposure.

Activity pattern

The activity pattern describes the location of the individual as a function of time.  In the context of the IAQ model, the location is either some room in the building or outdoors.  When the individual is located outdoors, the exposure is based on the outdoor concentration entered as part of the scenario definition.  When the individual is located in a room in the building, the exposure is based on the calculated concentration for the room at that time.

Analysis of IAQ control options must include analysis of the effects of the activity pattern on exposure.  Sometimes significant reduction in exposure can be achieved by slight modifications in activity patterns.  For example, Tichenor and Sparks (1994) show that an individual can reduce exposure to emissions from painting by waiting for 24 hours after painting is completed before entering the building.
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Introduction

Risk assessment is a general term that includes the four components: hazard identification, exposure assessment, dose-response evaluation, and risk characterization.  A risk assessment can be quantitative or qualitative depending on the data available and the requirements for the assessment.  RISK uses a risk calculation scheme described by Naugle (1991), Naugle and Pierson (1991), U. S. EPA (1991), and Pierson et al. (1991).  The calculation scheme developed by these authors provides a systematic way for estimating risk.   The purpose of this chapter is to present the risk calculation scheme developed by Naugle and co-workers.  This chapter is not intended as a primer on risk assessment.

Risk estimates based on currently available data are projections containing a great deal of uncertainty.  This is particularly true when using a model such as this one to calculate risk estimates for individuals, because such numbers as carcinogenic potency, upon which the model depends for calculating individual and population cancer risk, are projections of population risks based upon a variety of extrapolations and assumptions.  Risk estimates generated by models such as this one are useful mainly for the purpose of comparing scenarios rather than for determining absolute risks to individuals or populations.

Those interested in risk assessment should consult "The risk assessment guidelines of 1986," EPA/600-8-87/045, U. S. EPA (1987); Berry (1991); Lioy (1987); Pruess and Ehrlich (1987); Stolwijk (1992); and other references.  Issues involved in communicating the results of risk assessment are discussed in U. S. EPA (1988).

Mølhave et al. (1995) present an example of using an IAQ model to carry out a risk assessment.  This paper demonstrates the steps necessary to carry out a risk assessment. Mølhave et al. show the importance of obtaining the right data from source testing to carry out the risk assessment. They also demonstrate the effects of the assumptions involved in risk assessment by providing examples of the range of answers possible depending on the assumptions used.   Sparks et al. (1995) discuss source testing necessary to obtain data required for conducting risk assessment.

Risk characterization framework

The predictive risk equation developed by Naugle and co-workers is based on four general equations.  These equations relate source factors, activity patterns, dose factors, and dose response to risk.  The equations are:

Exposure

Concentration x Duration = Exposure

Dose

Exposure x Dosimetry factors = Dose

Individual risk

Dose x Dose-Response relationship = Individual Risk

Population Risk

Individual Risk x Exposed population = Population risk

The effects of IAQ control options on individual risk is generally the risk of interest for the IAQ engineering program.

The framework subdivides the four components of  the risk assessment process into ten elements to provide a refined and systematic way of describing the risk estimation process. These elements are:

· Source factors

The starting point for the risk analysis.  The estimation of risk can be based on the study of a single source emitting one or more pollutants of concern or the study of a pollutant or mixture that is emitted from one or more sources.


· Pollutant concentration

The pollutant concentration of interest depends on the effect that is of interest.  The concentration may be the peak concentration, the average concentration, or some threshold concentration.

· Exposure duration and setting


The exposure duration and setting combines the setting in which exposure occurs and an estimation of the time spent in that environment.

· Exposure

The outcome of exposure duration and setting is individual exposure.

· Dosimetry factor

The dosimetry factor addresses factors which influence how much of the exposure to a pollutant is available to the body.  For many air pollutants the major factor is inhalation rate.

· Dose

Dose represents the amount of a substance available for interaction with metabolic processes or biologically significant receptors.

· Response factor

Response factor describes the magnitude of the response of an individual to a given dose of the substance.

· Individual risk

Individual risk represents the risk of an individual exposed at the given concentration, duration, etc.  For cancer risk the individual risk is expressed as lifetime individual risk.

· Exposed population

Exposed population is the number of individuals that are exposed to the conditions covered by the risk assessment.

· Risk to exposed population (Population risk)

The risk framework and the predictive equations are most often applied to prediction of cancer risk.  Pierson et al. (1991) have shown that the framework may be applied to non-cancer risk if sufficient data are available.  

The risk calculation framework can be placed in a spreadsheet format for ease of calculation.  RISK uses the spreadsheet format to allow calculation.

Risk calculation framework

The risk calculation framework developed by Naugle and Pierson (1991) is shown in Figure 148.

	Concentration
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	Duration

t
	Exposure

E=C x t
	Dosimetry

 factors, F
	Dose

D=ExF
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	Lifetime Risk
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	Population

P
	Population Risk
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Figure 148. Form used to display results of risk calculation.

The IAQ model calculates the concentration, duration, and exposure.  The user must independently provide the dosimetry factors, the response factors, and the population.  

Units

Keeping track of the various units is a major problem in conducting a risk assessment.  It is important to be sure that the units used in the framework calculation are consistent.  

Exposure

Units of exposure are mg-h/m3 as can be seen from the definition of exposure as concentration x time exposed.  The exposure calculated by the model is mg-total hours/m3.  

mg/m3 * h  =    mg-h/m3
Inhalation exposure

Units of inhalation exposure are mg as can be seen from the definition of inhalation exposure as concentration x breathing rate x time exposed.

mg/m3 * m3/h * h  =  mg

Dosimetry factors

Dosimetry factors are used to convert units of concentration to dose and to account for factors such as efficiency of the exposure in reaching the target organ. The units of the dosimetry factor are those required to ensure that the units of exposure and dose are consistent.

Dose

The units of dose can be confusing and depend on the type of effect of interest.  For cancer risk dose is often expressed as mg/(kg-day), Tancrde et al.(1987). The definition of dose is Dose = Exposure x Dosimetry factors.  The dosimetry factors include factors necessary to convert from exposure units to dose units.  For example, the model calculates total lifetime exposure (mg-h/m3-lifetime).  In order to convert this to dose units of mg/kg-day, the dosimetery factors must include the body weight and the lifetime.

Dose response

Dose response is also referred to as potency and must have units consistent with the units of dose.  Cancer risk is often reported as (mg/kg-day)-1 which is consistent with the units of dose, mg/(kg-day).  

Cancer risk

Most risk characterization studies of environmental pollutants have concentrated on cancer risk.  Cancer risk is typically expressed as lifetime risk--the probability of developing cancer over a lifetime for the average individual in a defined  population and for a defined exposure scenario.  U. S. EPA (1991) presents a review of some of the cancer risk characterization studies.  

Cancer risk is given by-- Dose x carcinogenic potency

	Note that carcinogenic potency values are very uncertain and include numerous assumptions and extrapolations. \definition "Carcinogenic potency" 
	Carcinogenic potency for some compounds taken from Tancrëde et al.(1987) is given in Table 18.


Table 18.  Carcinogenic potency of some compounds from Tancrëde et al.(1987) .

	Chemical
	Carcinogenic potency (kg-day/mg)

	3-methypentane
	4.6 x 10-4

	benzene
	1.0 x 10-3

	toluene
	9.0 x 10-4

	p-dichlorobenzene
	6.7 x 10-4

	formaldehyde
	0.011

	passive tobacco smoke
	0.3

	1,1,1- trichloroethane
	1.7 x 10-5


Non-cancer risk

Non-cancer risks have received less attention than cancer risks.  Pierson et al. (1991) recommend that many of the mathematical operations used in the risk framework be dropped when it is applied to non-cancer risks.  Individual risk may be estimated as the probability of a response (adverse health effect) or the degree to which exposure or dose exceeds a threshold for adverse health effects.  

Irritant Risk

An irritant response to a substance often occurs when the concentration exceeds some threshold value.  Examples of irritant effects include eye irritation, odor, and nasal irritation.  The concentration required to produce an irritant effect may depend on individual susceptibility.   The duration of the irritant exposure is often important.  RISK provides information on the time spent above a user specified irritant threshold concentration.

The avoidance of irritant risk is a major consideration in indoor air quality.  For example, the ASHRAE ventilation rate standard 62-89 is designed to ensure that no more than 20% of the occupants of the building express displeasure with the indoor air quality.  A major consideration in developing the standard was to provide sufficient outdoor air to avoid complaints due to human body odor.

Mølhave (1986) discusses irritation in indoor air and presents limited information on the concentrations of VOCs that might cause irritation.

Wolkoff and Nielsen (1996) discuss a labeling system designed to minimize irritant risk from indoor materials.  Seifert (1992) also provides a system for evaluating sources that includes irritant risk as a factor.

There is considerable research to develop source test methods to provide information on irritant risk due to pollutant emissions from indoor sources.  Much of this research is based on using bioresponse testing to either replace or augment chemical testing.  Muller and Black (1995)  discuss one method of testing products to provide data necessary to estimate irritant risk.

Chronic risk

Chronic risk is also often associated with threshold-based doses.  Little research has been published to quantify the chronic risk of common indoor pollutants. Seifert’s, Seifert (1992) , source ranking includes chronic risk as a factor.   RISK provides information on the time spent above a user specified threshold concentration.  
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Calculator

General

The calculator is a simple four function calculator.  The calculator is shown in Figure 62.
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Figure 62.  Calculator

The calculator can be operated with the mouse or the keyboard.  Pressing C or clicking on C clears everything.  Pressing E or clicking on CE erases the current entry.  Pressing Enter or clicking on Enter is the same as pressing = or clicking on =, all operations are completed and the answer is shown in the display.

Edit

Clicking on Edit provides access to the Edit sub-menu.  The edit sub-menu has two commands, Copy which allows copying the current information in the calculator display to the Windows clipboard and Exit.

Help

Provides access to the on-line help system.

Units conversion

General

The units conversion calculator provides a way for converting from one set of units to another.  For example, if data in feet are available, the units conversion calculator can convert the data to meters.  The calculator is shown in Figure 63.
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Figure 63.  Units conversion calculator.

The units conversion calculator provides direct conversion of length, area, concentration, volume, and flow units.  The input value with the indicated units is converted to the output value with the indicated units.  In addition to providing for conversion from common units to other common units, for example from feet to meters, the calculator provides a user defined conversion as the last row of each sheet.  

The first column is used for entering data.  This column may be used to calculate the input if an equal sign, =, is entered as the first character.  For example, if the length 10 ft 5 in must be converted to meters, the data entry would be 


= 5/12 + 10  Enter

The display will then show :

10.450000000
ft
3.1750000
m

Note that the number of inches must be entered first.

The quantity, Length, Area, Volume, Concentration, Flow rate, or User, desired for units conversion is selected by clicking on the tab for that quantity.  Each of the units conversions is discussed below.

Length

The length conversion calculator is shown in Figure 63.  

Area

The area conversion calculator is shown in Figure 64.
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Figure 64. Area units conversion.

Volume

The volume units conversion is shown in Figure 65.
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Figure 65.  Volume units conversion.

Concentration

The concentration units conversion calculator is shown in Figure 66.
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Figure 66.  Concentration units conversion.

Concentration converts between parts per million by volume (ppmv) and mg/m3 or µg/m3.  The conversion depends on the molecular weight of the pollutant of interest.  The user must enter the molecular weight as part of the data entry.

Flow rate

The flow rate units conversion calculator is shown in Figure 67.
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Figure 67. Flow rate units conversion.

User

The user calculator is shown in Figure 68.  The user calculator is a spreadsheet.  Numbers can be entered into the spreadsheet.  Data from one cell can be referenced in a calculation in another cell.
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Figure 68.  User calculation spreadsheet.

For example, if length is entered in cell A1 and width is entered in cell B1, area can be calculated in cell C1 by entering:

= A1*B1.

The spreadsheet recognizes the common mathematical operations shown in Table 2.

Table 2.  Operations possible with units conversion spreadsheet.

	Operation
	Enter
	Example

	Addition
	 +
	2 + 2

	Subtraction
	 -
	3 - 2

	Multiplication
	*
	 4 * 2

	Division
	/
	6 / 3

	Raise to a power
	^
	 4^2 (4 squared)


Note that cells cannot be selected for use in equations with the mouse or the arrow keys.  They must be entered  manually by typing in the column and row for the cell.  For example, if the formula requires that the quantity in cell A1 be multiplied by the quantity in cell B1, type A1 * B1.

Menu items

File

File provides access to the command to close the units conversion spreadsheet.

Edit

The edit menu item provides access to copy and paste commands that allow data to be copied from the units conversion spreadsheet to the Windows clipboard and pasted into the units conversion spreadsheet from the Windows clipboard.

Help

Help loads the on-line help system.
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Introduction

The on-line help system provided with RISK uses the Windows' help system to display information from the manual.  The help system can be used to search for specific information on a topic and provides hypertext links between topics.  

Two help files are provided with the RISK program. The file RISK.HLP is an abbreviated version of this manual.  The file MANUAL.HLP is the full version of the manual.  When Help is selected, the file RISK.HLP is loaded for use by the Windows help system.  The file MANUAL.HLP can be loaded by selecting Help and then selecting File Open from the Help Menu.  When the file open dialog is displayed, enter MANUAL.HLP as the file to be loaded.

MANUAL.HLP can be loaded by default by renaming or deleting the file RISK.HLP and then renaming the file MANUAL.HLP to RISK.HLP.

Help on help

When you load the Windows help system, the main menu  will contain a Help option.  This help option is provided by Microsoft and provides guidance in using the Windows help system.  For example, if you click on help from the building form, the display shown in Figure A1-1 is displayed.
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Figure A1-1.  Help display from building form.

If you click on Help again, the Help screen for the Windows help system will be displayed.  This display is shown in Figure A1-2.
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Figure A1-2. Help sub-menu for Windows help system.

If the how to use item is selected, the display in Figure A1-3 is displayed.  The how to use screen provides full information on using the Windows help system.
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Figure A1-3. How-to-use help screen.

Help for Windows 95

RISK has been tested under Windows 95.  The only problem noted was that when the Windows 95 help engine loads the help files for RISK it reports an error.  A message “Help file contains an error.  Contact the vendor for an updated help file.” is displayed.  Ignore the error and use the help file provided with RISK.
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Introduction

Determining what values to use in IAQ modeling is a serious problem.  There are limited data available.  This appendix provides emission rates, sink rates, and air movement factors based on information developed by EPA's ongoing IAQ research program and selected data from the literature.  The data from EPA's research program is based on small chamber and test house experiments.  All of the data, whether taken from the literature or based on EPA's research, is of limited scope.  Source data, for example, generally apply to one brand or even one sample of a particular brand of a product.  The EPA test house data are based on a single house.  It is believed that the house is typical and a few limited experiments have been conducted in offices and other buildings to more or less confirm the insights developed from the test house experiments.

Source emission models and parameters

Source emission models and their parameters are given in Table A2-1 for a limited number of sources.  In some cases, information for more than one model is provided.  Note that most of these data are for single samples of a product. 

Table A2-1.  Model parameters for first order decay model sources R(t) = R0e-kt
	Source
	Pollutant
	R0
	k 1/h
	Comments

	Linoleum
	VOC
	1.8 mg/m2-h
	0.0001
	Danish research

	Painted walls
	VOC
	0.27 mg/m2-h
	8x10-3
	"                 "

	Ceiling material 
	VOC
	0.425 mg/m2-h
	1.2x10-4
	"                 "

	Lacquered parquet floor
	VOC
	0.247 mg/m2-h
	2.2x10-5
	"                 "

	Linoleum
	Formaldehyde
	5 µg/m2-h
	1x10-8
	"                 "

	Painted gypsum board
	Formaldehyde
	20 µg/m2-h
	8x10-5
	"                 "

	Painted gypsum ceiling
	Formaldehyde
	9 µg/m2-h
	1.8x10-4
	"                 "

	Lacquered parquet floor
	Formaldehyde
	12 µg/m2-h
	2.7x10-4
	"                 "

	Occupancy
	VOC
	30mg/h
	0
	"                 "

	Moth cakes
	p-dichlorobenzene 
	1.4 mg/cm2-h
	0 
	Sparks et al. (1991)

	Dry cleaned clothing
	perc
	1.3 mg/m2-h
	0.03
	Sparks (1991)

	Wood stain
	VOC
	17,000 mg/m2-h
	0.4
	"                 "

	Polyurethane varnish
	VOC
	20,000 mg/m2-h
	0.25
	"                 "

	Wood floor wax
	VOC
	20,000
	6
	"                 "

	New Carpet
	4 PC
	150 µg/m2-h
	0.0036
	EPA research

	Polomyx coating
	VOC
	27.5 mg/m2-h
	0.26
	"                 "

	Liquid Nails adhesive
	VOC
	26,800 mg/m2-h
	0.43
	"                 "


Gas-phase mass transfer models are appropriate for many of the sources listed in Table A2-1.  The source data base included with RISK provides mass transfer parameters for many of these sources.  Sparks et al. (1995) provide guidance for converting data for empirical models to gas-phase mass transfer parameters.

Steady state sources can be simulated in the model by setting the decay constant to 0.

Aerosol spray or other short burst type sources can be simulated in the model by using a first order decay model with k = 0 and with the time between source on and off very small.  Note that if the time between source on and off is small, the calculation step must also be very small to ensure that the model captures the time on and time off events.  The calculation step size can be changed using the options item found in the building form.

Note that sources with very large decay constants, k, require a small calculation step size to accurately capture the time history of the emissions.  Sources with small decay constants, k, can be used with fairly large values of the calculation step size.

Suggested values for ventilation, room-to-room air flows, and other model parameters are provided in Table A2-2.  Most of  these values are based on EPA test house experiments.  Suggested value for floor-to-floor flows is based on discussions with researchers in the field and very limited field data.  

Table A2-2.  Suggested values for model parameters.

	Parameter
	Suggested value
	Comments

	Natural ventilation
	0.2 to 1.5 ACH
	0.5 is reasonable for construction after 1970.

	Natural room-to-room flows
	2 to 6 room volumes/h 
	Based on smaller of the two rooms.

	Natural floor-to-floor flows
	20 to 50 m3/h 
	Most of flow is up due to stack effect.  Must be balanced by outdoor flow on lower floors.

	HVAC and HAC flows
	5 to 6 room volumes/h
	In a residential situation the HAC flows are cyclic with the system turning on and off.  

	Particle air cleaner efficiency--furnace filter
	10% for particles in the respirable range.  
	Single-pass efficiency

	Particle air cleaner efficiency Standard HVAC filter
	13% for particles in the respirable range.
	Low efficiency ASHRAE filter

Single-pass efficiency

	Particle air cleaner efficiency electrostatic precipitator
	80% over entire particle diameter range.
	Includes sneakage

Single-pass efficiency

	Particle air cleaner efficiency furnace filter replacements 
	18% for particles in the respirable range.
	Electrostatic augmented low pressure drop filters

Single-pass effficiency

	Particle air cleaner high efficiency filter
	70% over entire particle diameter range.
	Includes sneakage

Single-pass efficiency

	Breathing rate
	0.833 m3/h
	


Suggested values for sink constants are given in Table A2-3.  These values assume that the Langumir sink model, n = 1, discussed in the sink theory section of the model is valid.

Table A2-3.  Suggested values for sink constants.

	Material
	Pollutant
	ka m/h
	kd 1/h

	Carpet
	TVOC
	0.1
	0.008

	Painted wallboard
	TVOC
	0.1
	0.1

	Ceiling tiles
	TVOC
	0.1
	0.1

	All surfaces
	P-dichlorobenzene 
	0.35
	0.01


If data necessary to calculate the gas-phase mass transfer coefficient are not available, assume a value of 2 m/h.  The concentration time history is not a strong function of the gas-phase mass transfer coefficient.
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Introduction

A simple source database is provided with RISK.  The database is designed to allow the user to retrieve data for use in RISK.  The database provides information on the type of source model and the parameters for the source model.  For some sources, more than one source model is provided.

This appendix provides a short overview of the source database and provides instructions on how to use it.

Accessing the source data base

The source data base can be reached from the room sources menu, see Figure 55.  When open source data base is selected, the list of sources in the data base is displayed, Figure A3-1.  The SourceID is an index number used by the data base. Source name is the name of the source.  The description is any information about the source that is useful  further defining the source.  Pollutant is the pollutant emitted by the source.  Emission is the emission model for the source.  Reference is the source of the information.

At the bottom of the figure a table of emission model parameters is displayed.  This table is filled in by clicking on the source of interest.  For example, to see the emission model parameters for linoleum, move the cursor to linoleum and click the left mouse button.  The information shown in Figure A3-2 is displayed.  The information from the source data base can be transferred to the program by selecting File Transfer (Alt F T).

At present the source data base cannot be updated from RISK.
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Figure A3-1. Source data base display.
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Figure A3-2. Source data base display showing emission model parameters.
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		DBCP=1,2-dibromo-c-chloropropane		0.0056		2350		42		0.114
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		TCA=1,1,1-trichloroethane		0.57						1.74
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